31

PAGES OF WINDOWS
STEP-BY-STEP GUIDES

DO MORE WITH YOUR PC

IMPROVE WINDOWS 10

MASTER CORTANA'S AMAZING NEW FEATURES

THE PERFECT W$Y TO

PLUS!
0$.($1<
PC START UP
FASTER

REINSTALL
WINDOWS
Make any PC more reliable and easier to use with our 10-page guide

A
ALSO
INSIDE...
Fast photo Àxes
File Explorer tips
Security cameras
Save battery life
Fix PC
P problems
p
Tweet like
Tw
lk a p
pro

TIPS FOR RUNNING
OLDER VERSIONS
OF WINDOWS

NEW TECH TESTED & RATED
N
-%/3/$</,6763($.(5  LENOVO MII; 
 %LUETOOTH HE$DSETS  &+8:,/$3%22.

;OLZV\YJLMVY[LJOI\`PUNHK]PJL
techradar.com

Welcome
If your PC no longer runs as
quickly or as sweetly as it did
when you first bought it, then
reinstalling Windows could be the
best way to restore your
computing sanity.
In our lead feature starting on
page 14, we explore five different
ways you can reinstall Windows 7,
8.1 or 10 – from a simple repair or
refresh, to a full reinstall where
you wipe everything on your PC’s
hard drive and start over.
As ever our Explore section
(starting on page 27) is packed

with step-by-step guides to help
you get more from your PC –
from simple ways to make your
PC start faster to the latest
enhancements to Cortana.
If you own an older PC running
Windows 7, we’ll also show you
how to keep the operating system
alive with our in-depth feature
starting on page 66. And if you’re
thinking of getting into smart
home technology, be sure
to read our home security
camera guide (page 60).
Enjoy the issue,

Rob Mead-Green Editor

www.facebook.com/windowsmag
SUBSCRIBE TO THE MAG TODAY
AND SAVE – JUST TURN TO PAGE 24!
We pride ourselves in being the only
magazine on the shelves to show you
exactly how to get the very best from
the Windows operating system, whether
you’re using Windows 10 or Windows
8.1. Also, don’t forget to take a look at
how you can read the magazine on your
laptop, smartphone or tablet.
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MARK IT Make a note of it on your phone
and you’ll remember later at home.
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The Knowledge…

Organise your life and
never forget a thing
Combine your Windows PC, the internet, and your
smartphone to keep a note of every single task
Everything is interconnected these days.
While this obviously helps advertisers see
what sites you’ve visited and repeatedly
show you ads for things you don’t want –
mentioning no names, Amazon – the fact
that your PC and phone are both hooked up
to the internet at all times means you can
keep a fully updated diary or to-do list
current no matter which device you’re using
An obvious ﬁrst candidate for doing that
might be OneNote. It comes bundled with
Windows 10, and is perfect for sketching
quick notes. Link it
with your OneNote
account, and you can
open sychronised
notebooks on a
similarly-linked mobile
version of the app.

to manage it with Windows’ built-in
Calendar app, it’s simply a case of adding
your Google account via its settings screen.
You’ll then see everything that you’ve
already booked in online, get alerts in your
Windows Action Centre, and can add new
items to that same Google calendar which
will be reﬂected on each one of the devices
that you have connected.
While your to-do list could be well served
by Google’s neat Keep application, which
has mobile versions and a web interface,
there’s no good way
to access that through
a Windows app.
Todoist (www.
todoist.com) on the
other hand, is perfect
for synchronising your
upcoming tasks
between your smartphone, the web, and its
Windows 10 app, which is available, as a free,
download from the Windows Store.
Todoist has some paid-for features, but it’s
super-useful even if you don’t cough up,
turning getting your tasks done into a
points-scoring game.

You can keep a fully
updated diary no
matter which device
you’re using

WORK TOGETHER
Collaborative calendars are perfect for a
connected family. We in the oﬃce tend to
favour Google Calendar, which has a host of
easily accessible mobile apps and a web
interface at calendar.google.com. Google’s
Calendar format is open, too; if you wanted

MECHANICAL KEYBOARDS The clack is back
Once upon a time, the noisy, satisfying click
of a mechanical keyboard was the norm.
Most keyboards nowadays use dome
switches, with a cheap silicon membrane
and a single circuit board replacing
potentially hundreds of pricey switches, but
there’s a growing movement propping up a
new wave of tactile noisy keyboards. While
you can pull a good one oﬀ the shelf for
upwards of £75, expect to pay a lot more for
the bespoke variety…

CAP IT Artisan keycaps are highly sought after by
keyboard customisers but can cost a pretty penny.

Windows Phone
What’s happening with Windows Phone?
Well, it’s dead. Microsoft has oﬃcially put
the hammer down and ended all support
for Windows Phone 8.1, only three years
after its original release. Handsets won’t
stop working, but there’ll be no more
updates. So if you’re rocking a classic
Lumia phone, you might want to start
looking for a replacement.
What does this mean?
Technical help is oﬀ the table, for a start. If
you run into a problem, you’re on your
own. And, at least in theory, Windows
Phone devices could now pose a security
risk; without the latest updates, there’s a
possibility that a determined hacker could
slip something nasty past its defences
– although Microsoft has been known to
issue patches to unsupported platforms,
including Windows XP, should something
serious come up.
Why has this happened?
Windows Phone, for all its positives, wasn’t
the runaway success that Microsoft has
hoped it might be. In fact, it was a failure:
it topped out at 10% UK market share, and
recent stats suggest that Windows Phone
accounts for less than 1% of the total
market. It was time for it to go.
So Microsoft is done with phones?
Not by a long shot. Windows Phone might
be done, but Windows 10 Mobile still
seems to be a big part of Microsoft’s plans.
There are persistent rumours that new
handsets maybe in the works, and CEO
Satya Nadella has hinted that they might
not be traditional black rectangles. What
that means, though is as yet unknown.

WHITE DELIGHT The WhiteFox keyboard includes
custom-designed switches and LED lights.

CUT DOWN Many niche designs exist, allowing
new mechanical keyboards to get super-compact.

What’s up next?
Quite possibly a rather major launch: word
has been bubbling about a Surface Phone
for some time, and given the care and
attention that Microsoft has devoted to its
Surface line of tablets and laptops, it could
be the device that pushes Windows 10
Mobile to new heights. It won’t be cheap,
though – nothing Surface is.
Any idea when?
Rumours suggest a late 2017 launch with
handsets going on sale in 2017 or 2018.
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The big Kodi crackdown

The media centre itself isn’t the problem – it’s the way
people are using it that has regulators fuming
Kodi, once known as XBMC, is one of the
most popular media centre apps around.
With versions available for everything
from the PC desktop to Android and
beyond, the open-source software – this
means it’s free to use and modify – is the
most widely installed media centre, too.
There’s absolutely nothing wrong with
using Kodi, but its ability to run
extensions, many of which vastly simplify
the task of gaining access to less-thanlegal content, has movie studios and TV
networks up in arms
– and the fact that
some unscrupulous
retailers are selling
boxes loaded with
these extensions has
led to legal action
from organisations
far and wide.

LETHAL FORCE
Some of the most popular Kodi piracy
add-ons, like Exodus and Phoenix, have
been seemingly scrubbed from the
internet. Attempting to download them
now leads to errors, and the sites hosting
the illegal streams and ﬁles they relied
upon have been targeted with
takedown requests or legal action from
major studios. While others will likely pop
up in time – such is the nature of these
things – there’s no doubt that Kodi’s brief

run as the de facto leader in plug-andplay piracy is nearing its end. Users of
these add-ons should be worried, too:
the EU Court of Justice has recently
made a ruling, which clariﬁes that
streaming an illegally-reproduced movie
or TV show is an equivalent oﬀence to
actually downloading it.

KODI’S REACTION
While it’s been eﬀective in taking down
many of the big oﬀenders, this
crackdown isn’t
entirely playing fair
to the otherwise
perfectly legal Kodi.
Facebook, for
example, now
prohibits sale of
‘products or items
that facilitate or
encourage
unauthorised access
to digital media’, which includes Kodi
boxes – whether they’ve been loaded
with nefarious extensions or not. The
social network joins eBay and Amazon in
prohibiting their sale. But you’re still free
to install Kodi on your own, and its team
of volunteer programmers isn’t angry. In
a post on kodi.tv, developer Christian
Hewitt stated: “if the Kodi userbase drops
a huge percentage because pirate
services ﬂee or die, we’re ﬁne with that.”

Download this…
It Is As If You Were
Doing Work
https://pippinbarr.github.io/
itisasifyouweredoingwork/

A weird one, this. Part game, part art project,
part nostalgic resurrection of classic Windows
sounds, It Is As If You Were Doing Work is, as
its title suggests, a simulation of doing
computer busywork. You’ll mash your
keyboard to type documents, set dates, tweak
sliders, close pop-ups, and inevitably be
interrupted just as you were getting a task
ﬁnished. Now and then you’ll be granted an
enforced break, during which you can play a
simple version of Breakout, change your
desktop wallpaper, or put on some music,
then it’s back to work. Over time you’ll earn
promotions and work your way up through
the company ranks although this, perhaps to
make a statement about the futility of work,
gets you absolutely nothing bar a new title.
This might not last you long, but it’s strangely
satisfying to do fake work when you’re taking
a break from the real thing.

LOOK FAMILIAR? Keep up with your work or
your desktop will get swamped.

Follow us on…
www.twitter.com/windowsmag

ƹƾ,=
7+(6(&ǖǕ'
ʖ ȷ ɏV Wʋ UWɡQ ʝɦ
3ʑ QɡD ɢʃ ȱ ɏȾHD ʏ ɨ\ʝ ʦ ɠʤ

1

3

Which is not used to
switch between
programs?

Which of these file
types is an image?

A .exe
B .doc
C .png

2

What does PDF
stand for?

A Police Department File
B Perishable Document File
C Portable Document
Format

5

Which of these files
would you expect to
be the largest?

A [Alt] + [Tab]
B [Ctrl] + [Enter]
C [Win] + [Tab]

A .txt document
B .wmv movie
C .jpg image

4

What do .zip, .rar
and .7z files have
in common?

Which program
opens .ppt files?

A Paint
B Notepad
C PowerPoint
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NEXT ISSUE ON SALE
Friday

A They are compressed
B They are movie files
C They are viruses

Answers 1C, 2A, 3B, 4C, 5B, 6A
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Rob Mead-Green reveals a host
of fascinating digital facts

2020

The year when Adobe will stop supporting Flash. The
company made the announcement in July. At one stage Flash
could be found on 98% of internet-connected computers.
Now it’s only used on 17%. It’s gradually being supplanted by
more open and efficient web standards, such as HTML5.

Number of people who now subscribe to Netflix,
the movie and TV streaming service. It added 5.2
million more subscribers in the last quarter thanks,
it says, to its “strong slate of content.”

165
$200

Number of people Amazon boss, Jeff Bezos, thinks
will eventually colonise space using reusable
rockets… ones built by his privately-owned spaceship
company, Blue Origin, presumably.
12

|

| September 2017

Price of Oculus Rift’s
first standalone VR
headset, which will be
launched next year.
The wireless headset
– codenamed Pacific
– is optimised for
portability, and you
won’t need to hook it
up to a smartphone
or a PC to be able
to use it.

Average speed, in
miles per hour, of
the world’s fastest
drone. The RacerX,
designed and built
by Drone Racing
League engineers,
was awarded a
Guinness World
Record for the
fastest ground
speed by a
battery-powered,
remote control
quadcopter in
July. Its peak
speed was
179.3mph

Incoming

The hottest new Windows hardware on the horizon

Apple HomePod
Price $349, www.apple.com
With a new version of iTunes coming to the Windows Store at the end of the
d.
year, now’s the time to look at another upcoming Apple product: the HomePod.
Designed to compete with Google Home and Amazon Echo, the HomePod iss
a smart, multi-room speaker that not only enables you to play any one of 40
million songs from Apple Music just by asking Siri; You can also ask it to control
other smart devices, including smart thermostats, lights and other gear.
The really clever thing about the HomePod, though, is its combination of
room-sensing and beamforming technologies, which enables the speaker to
‘tune’ itself to the space it’s in and deliver high qualiy, room-ﬁlling sound
accordingly. You can also link several HomePod speakers in diﬀerent rooms
together using AirPlay 2 for whole house sound. Available December.
S p
September
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PICK YOUR PERFECT

REINSTALL
There many ways to reinstall Windows. Nick Peers
helps you choose the right one, whether you’re
reinstalling Windows 7, 8.1 or 10

R

einstalling Windows
is like death, taxes
and washing up –
try as hard as you
might, you can’t put
it off forever. The
reinstall process is traditionally
associated with giving your PC a
major clearout – restoring it to its
halcyon days when it fairly Áew
through the tasks you put in front of
it. But reinstalling Windows can also
Àx any non-hardware problems,
remove corrupt Àles and
misbehaving programs to give you
back control of your PC.
Not all reinstall processes are the
same, however. In this feature, we’ll
look at Àve different scenarios.
There’s the repair install that Àxes
minor problems without affecting
your programs, Àles or settings, as

14
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well as the more familiar destructive
install that removes everything and
gives you a clean slate. But we’ll also
touch on reinstalling from recovery
partitions, downgrading your
version of Windows to an earlier
version and setting up a dual-boot
setup that allows you to run two
different versions of Windows
side-by-side.
Oh, and because reinstalling can
be a dangerous business, we’ll also
reveal all the tips and tricks you
need to back up all your data and
settings, along with what to do to
bring it all back again once the
reinstall process has Ànished.
Long story short, once you have
Ànished reading this feature you’ll
be armed with everything you need
to know about reinstalling
Windows. Let’s get started…

Windows 10
Pick your perfect reinstall
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|

15

Before you reinstall
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A

full reinstall is a
destructive process –
everything on your C
drive will be wiped clean
as a result. Even if you
perform a repair install,
there’s still the danger that it won’t ﬁx
your problem and might even make
things worse, preventing you from
getting at your data. Therefore, it’s
important to take steps to protect your
personal ﬁles and maybe your
preferences and system tweaks too.
Step one is to look after your personal
data: documents, photos, videos and so
on. By default, these are stored inside
your personal user folder on the same
drive as Windows itself. So if you’ve not
moved these folders on to another
drive, it’s critical you back them up now.
Windows has all the tools you need:
Backup and Restore in Windows 7, 8.1
and 10; and File History, which is limited
to Windows 8.1 and 10.

Check File History is
switched on in
Windows 8.1 and 10.

USE FILE HISTORY

If you’ve not already set either up to
back up your data, now is a good time
to start. File History is the better tool if
your version of Windows supports it, as
it makes it easy to roll back your data to
an earlier point in its existence as well as
saving the latest version. Set it up via
Settings > ‘Update & recovery’ > Backup
(Windows 10) or Control Panel > System
and Security > File History (Windows
8.1), then make sure it’s backing up the

folders you want it to and that at least
one full backup has been performed.
The Windows Backup and Restore
Tool (type ‘sdclt.exe’ to access it via the
Run dialogue box) is straightforward to
set up too – just click ‘Set up back-up’ to
get started if you haven’t already; if you
are using it, open it and take a new
backup immediately prior to reinstalling
to ensure your backup is fully up to date.
Like File History it can store multiple
versions of the same ﬁle, but fewer
revisions are stored.

BEYOND YOUR DATA

Back up program settings
If you’d like to transfer selected program settings from old installation to new,
download the portable CloneApp tool (www.mirinsoft.com) to your backup
drive. Once complete launch the tool by right-clicking CloneApp.exe and
choosing ‘Run as administrator’ and go through its list of 247 supported apps
to see if yours are there. If any are, tick the box beside each one you want to
save the settings for. If any apps aren’t covered – or you want to back up
additional settings – then choose Custom where you manually specify the
ﬁles, folders and Registry keys where your program settings are stored.

16

|

| September 2017

The ‘Back up your program settings’ box
on the left tells you how to back up your
program settings using a free program
called CloneApp – if you’re struggling to
track down a program’s settings, check
its support pages or forums online, or
start your search under the C:\
User\<username>\AppData and C:\
ProgramData folders as well as the app’s
own folder under C:\Program Files or C:\
Program Files (x86). Also open the
Registry Editor (type ‘regedit’ into the
Run dialog) and look under the HKEY_
CURRENT_USER\SOFTWARE Registry key
for any subkeys related to your apps.
What happens if you miss a crucial ﬁle
or setting? This is where your ﬁnal
backup – a fail-safe drive image – comes
in. You can click ‘Create a system image’
in the Backup and Restore Tool or – if
you want greater ﬂexibility – we
recommend installing Macrium Reﬂect
Free from www.macrium.com/
reﬂectfree.aspx. Once installed, launch
the program and click ‘Create an image
of the partition(s) required to backup
and restore Windows’ to get started.
Macrium Reﬂect Free is also a lifesaver
if you’ve come to this feature locked out
of Windows and with no backup in place
– follow the step-by-step guide on the
facing page to create DVD or USB ﬂash
drive rescue media and recover your
data before wiping your PC’s main hard
drive and reinstalling Windows.

Windows 10
Pick your perfect reinstall
Take a failsafe backup

1

FLUVWVWHSV

3

CUHDWHUHVFXHPHGLD

5

QXLFNÀUHDFWLRQV

If you don’t have Macrium ReÁect Free, install the
program on another PC. On Àrst launch, opt to create the rescue
media when prompted or choose Other Tasks > Create Rescue
Media – you’ll need a blank DVD or (preferably, because it’s
quicker an 8GB USB Áash drive.

If an update is found, click Next again to apply it. Once
the image is created, select your target device (DVD or USB . Tick
both boxes and click Finish. Wait for the media to be created,
then eject the drive safely and insert it into your afÁicted PC.

Click on your afÁicted Windows partition – an Actions
drop-down menu will appear. Click this and choose ¶Analyse File
System’ to check for errors. If none are found, make sure only the
partitions on your system disk are ticked, then click ‘Image
selected disks on this computer’.

2

GHQHUDWH3(LPDJH

4

BRRWIURPUHVFXHPHGLD

6

Back up everything

Macrium will suggest a PE version that matches the PC it
was installed on – if this is running a different version of Windows,
click ‘Change PE Version’ to choose the correct one. Click Next
twice, select your type of Windows (32-bit or 64-bit and click
Next to build the PE image.

Make sure your backup drive is connected and has
plenty of free space. Boot from your Macrium rescue media –
ignore any prompt to load network drivers. Once loaded,
switch to the Disk Image tab where you should see both your
non-booting system drive and your backup drive.

Click the ellipsis (… button next to Folder to select your
backup drive. Then click Advanced Options, select Auto Verify
Image and tick the ¶Verify image or backup Àle directly after
creation’ box before clicking OK followed by Finish. Your drive
and its contents will now be backed up. Q
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Repair a Windows install
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route to go down. Here’s what you need to do…

N

ot all reinstalls require a
complete wipe of your
hard drive. A repair or
refresh installation
leaves your programs,
settings and ﬁles in
place, and restricts itself to installing a
fresh copy of your Windows ﬁles over
the top of your existing copy. If your
problem is linked to a corrupt ﬁle or
Windows setting, the repair installation
can usually ﬁx it.
All repair installs share one common
characteristic: you must launch them
from Windows itself. You can’t boot
from your install media and repair
Windows through that; you need to
boot into Windows, then start the repair
process from there. If you’re unable to
boot into Windows, therefore, you’ll
need to skip to page 20 and perform a
full destructive recovery instead.

Start the repair

Starting a repair install varies depending
on your PC model and what version of
Windows you’re running. Windows 8.1
and 10 users should (at least initially)
avoid the Refresh/Reset options
provided under Settings > ‘Update and
recovery’. These options will preserve
your ﬁles and any apps you’ve installed
through the Windows Store, but any
desktop programs you’ve installed will
be wiped along with Windows itself.
Instead, you should ‘upgrade’ your
copy of Windows, which performs a

Windows 10 users can launch a repair install directly from the Media Creation Tool.

similar non-destructive reinstall to reset/
refresh with the added bonus that all
your programs – including those you’ve
installed outside of the Windows Store
– will be preserved. To do so, you’ll need
your Windows installation media – see
the step-by-step guide on page 17 if you
don’t have the latest version of it.
Why do you need the latest install
media? It’s because upgrade installs
only work if the version of Windows on
your PC matches that on your install
media, so if you’ve installed Service Pack
1 in Windows 7, for example, you need
up-to-date installation media to avoid

the laborious task of ﬁrst attempting to
uninstall Service Pack 1 through
Windows Update (assuming that you’re
able to), then reinstalling Windows and

Both
h Wind
i ows
w
8.1 an
nd 10
oﬀer a similar
way
y to re
repai
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your Windows
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n tallation
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Post repair steps
Start by stress-testing your
desktop to verify that
everything works as it should
– sometimes the repair can
introduce more problems than
it solves, in which case if you’re
running Windows 8.1 or 10 you
can undo the changes. Go to
Start > Settings > ‘Update
recovery’ > Recovery and look
for an option to go back to
your previous version – click
‘Get started’ and then follow
the prompts.
If the repair doesn’t appear
to Àx your underlying problem,
Windows 8.1 and 10 users can
take one more intermediate
step – the reset or repair. It will

18

|

see you waving goodbye to all
those desktop programs you’ve
installed (including OfÀce and
your third-party security
software , but it will preserve
your Windows Store apps, Àles
and Windows settings. Leave
your install media inserted,
then head over to the ‘Update
recovery’ > Recovery section
under Settings. This time, click
the ‘Get started’ button under
the Refresh (Windows 8.1) or
Reset (Windows 10) option and
follow the prompts.
If this more drastic approach
doesn’t work, or you’re running
Windows 7, then to page 20 for
destructive reinstall options.

| September 2017

Windows 8.1 and 10 users can perform a more drastic repair install via the
Reset or Refresh option -be warned, you’ll lose your desktop apps.

Windows 10
Pick your perfect reinstall
then downloading and reinstalling
Service Pack 1, along with all of your
other updates.
Windows 10 users can also launch the
repair process directly from the Media
Creation Tool by choosing Upgrade
when prompted, but given the amount
of time it takes to download the ﬁles,
you might as well create your install
media instead – just in case the upgrade
install doesn’t work and you decide to
go down the path of a full-blown
destructive install.

/DXQFKWKHUHSDLUSURFHVV

The procedure from this point onwards
varies according to which version of
Windows that you have. If prompted to
download updates, do so to save time
post-install.
Windows 8.1 and 10 users will be
asked what they want to keep. Windows
8.1 users should ﬁnd settings, personal
ﬁles and applications are selected by
default (click ‘Change settings’ if this
isn’t the case), while it’s ‘Keep personal

Choose the Upgrade option when prompted to repair Windows 7.

“Start by seeing if the specific issue
has been solved, then check to see
that the rest of Windows still works”
ﬁles and apps’ in the case of Windows
10 (don’t worry, in this circumstance,
‘apps’ also applies to any desktop
programs that you have installed).
Windows 7 users need to pop in their
install media, double-click setup.exe
and follow the regular reinstall process.
When prompted, click ‘Go online to get
the latest updates for installation
(recommended)’ to download post-SP1
security ﬁxes now, then accept the
licence agreement and choose
‘Upgrade’ when prompted.

The upgrade process can take up to
an hour on whichever version of
Windows you’re repairing, even on the
fastest machine, so be patient. Your PC
will reboot several times. If you’re
reinstalling Windows 7, you’ll be
prompted to enter your product key
again, so have it handy.
Windows 8.1 and 10 will relaunch with
the same setup wizard you’d see when
upgrading from an earlier version of
Windows. It’s all very straightforward,
but don’t skip through the Express

settings when prompted; make sure you
review all settings to lock down privacy.
If all goes well, you should ﬁnd
yourself at the desktop, ready to see if
your problem has been ﬁxed – start by
seeing if the speciﬁc issue that you were
experiencing before has been solved,
then check to see that the rest of
Windows still works as it should – if it’s
not, follow the advice in the ‘Post repair
steps’ box on the facing page. There’s
also a possibility – particularly with
Windows 7 – that the repair install will
result in a non-booting PC. If this
happens, it’s time to dig out the rescue
media you created using Macrium
Reﬂect Free and use it to restore the
drive image you took before embarking
on the repair process. Then turn the
page for more destructive options.

Get the latest install media

1

WLQGRZV

Head to www.microsoft.com/
software-download/windows10 and click
‘Download tool now’. Once downloaded,
open MediaCreationTool.exe. When
prompted, select ‘Create installation
media’ and follow the prompts to create a
either a USB Áash drive or an ISO Àle (for
burning to DVD).

2

WLQGRZV

Download the Media Creation
Tool from www.microsoft.com/softwaredownload/windows8 – input your
language, edition of Windows 8.1 and PC
architecture (32-bit or 64-bit) and then
click Next. Choose to create either a USB
Áash drive or an ISO Àle and then follow
the prompts to the end.

3

WLQGRZV

Go to www.microsoft.com/
software-download/windows7 and enter
your product key – choose a 32-bit or
64-bit version as required. Once
downloaded, double-click the Àle to burn
to DVD, or use the Windows USB
Download Tool (https://wudt.codeplex.
com) to create a USB Áash drive.
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A full, destructive reinstall

,I\RX¶UHORRNLQJWRZLSHWKHVODWHFOHDQRUQHHGWRUHFRYHUIURPPDMRU
LVVXHVWKHQXFOHDURSWLRQLVDOZD\VWKHEHVWRQH

R

einstalling Windows
from scratch – namely,
wiping your system drive
completely clean to
install a brand, spanking
new (and fresh) version
of Windows on to it – is the ultimate
choice for anyone looking to revive a
slow PC or resolve a major, nonhardware issue. In this section of the
feature we’ll step you through the entire
process – if you’re looking to reinstall an
older version of Windows, or explore
other reinstall options, turn to page 22.
Before you begin, make sure your PC
is fully backed up by following the
advice in the ﬁrst section of this feature.
A full reinstall really is destructive –
nothing left on your C drive will exist
once you’ve ﬁnished. You should also
follow the step-by-step guide on page
17 to ensure you have the latest
installation media for your target
version of Windows. This will ensure a
cleaner, more up-to-date installation
from the oﬀ, thus saving you time
bringing it fully up to date once the
installation has completed.
It’s also worth sourcing networking
and graphics drivers now rather than
relying on Windows to provide them for
you – in most cases, they should be built
in, but not always. Consult your PC or
motherboard manufacturer’s website for
these, or visit your Wi-Fi adapter or
graphics card manufacturer’s site –
download them to your backup drive.

Windows 10 users can launch a repair install directly from the Media Creation Tool.

Other things to consider: uninstall any
products that require activation now –
this should deactivate the licences and
allow you to use them with your new
install without any issues. Also, be sure
to have product keys and program
installers to hand.

actual reinstall process doesn’t diﬀer
much across Windows 7, 8.1 or 10. You’ll
be asked to verify your language,
location and keyboard are set correctly,

STARTING THE
REINSTALL PROCESS

A full destructive reinstall should always
be started by booting from your
installation media, be it a DVD or USB
ﬂash drive. Check the step-by-step
guide on page 17 for some pointers. The

Windows 7 and 8.1
users will ﬁnd a
large number of
updates waiting
to be installed
after reinstalling.

Restore programs, settings and data
Once Windows is reinstalled,
open Windows Update to
bring Windows fully up to date
– don’t be surprised if there are
hundreds of updates still to
apply in the case of Windows 7
and 8.1. Once it’s fully up to
date, consider reinstalling
Macrium ReÁect Free and
taking your Àrst drive image
– a vanilla backup you can
restore in future instead of
reinstalling Windows itself.
Next, it’s a case of
reinstalling your core apps.
Once in place, open CloneApp
from your data drive. If you
click the Restore button, every
single program setting you
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backed up will be restored – if
there are any backup settings
you don’t want to restore,
select Options to locate the
backup folder, then open it and
move any program folders you
want to ignore out of the
folder temporarily before
clicking the Restore button.
Now, take your second
Macrium ReÁect backup – a
‘perfect’ snapshot, as it were.
Finally, open File History or
the Windows Backup and
Restore tool and take steps to
restore any data you backed
up, then make sure the tool is
conÀgured to carry on backing
up going forward.
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Open File History, link it to your previous backup and then you can
restore all your data back to its original location with one click.

Windows 10
Pick your perfect reinstall
then it’s a case of clicking Install Now. If
prompted, enter your product key or
click Skip if you’re running Windows 10
on a PC you upgraded during the free
period. When asked what type of
installation you wish to perform, choose
the Custom option.
Next comes potentially the trickiest
part of the process. A list of drives and
partitions will appear – you need to
select the one Windows is currently
installed on. By default, it should be
detected and selected, but verify it’s
correct before clicking Format (click the
advanced Drive Options button if it’s
not visible). Click OK, then once
formatted, verify the drive is still
selected and click Next.
That’s the technical stuﬀ pretty much
done. You’ll see a checklist of tasks to be
performed – just sit back and wait. One
thing: when Windows reboots, you may
see the ‘press any key’ prompt again to
boot from CD or DVD. Don’t press
anything to let the installer continue.

Make sure you’ve got network and graphics drivers sourced.

“Next comes potentially the trickiest part of the process.
A list of drives and partitions will appear – you need to
select the one Windows is currently installed on”
SET UP POST-INSTALL

The post-setup prompt begins with
Windows 7 users being prompted for
their product key, then it’s a case of
setting up a user account and you’re oﬀ
and running. Windows 8.1 users will get
an Express Settings prompt – be sure to
click the option to customise these and
go through them carefully.
Post-Creators Update, Windows 10 no
longer gives you an Express Settings
option. For now, conﬁrm your location
and keyboard, set up your network if

required and choose ‘personal use’
when prompted. You can either sign in
with your Microsoft account or click
‘Oﬄine account’ > ‘Maybe later’ if you
plan to stick with the old-style Windows
7 local user account.
If you opt for the Microsoft account
option now is a good time to set up a
PIN to speed up future logins (note: the
PIN is tied, speciﬁcally, to this PC, and
you can always bypass it using your
regular account password should you
forget it at any point).

You’ll then be asked to set up Cortana
– this is where Windows 10’s notorious
privacy settings come into play, so
review all of the options carefully,
ﬂicking the slider to Oﬀ for any you
don’t need or use.
That’s the end of the setup process
– Windows will now conﬁgure itself
based on each of your choices and you’ll
see a series of messages appear
on-screen. Eventually, when all is ready,
you’ll ﬁnd yourself back at the familiar
Windows desktop screen.

Start the install process

1

RHERRWIRUPHGLD

If you’re running Windows 7, or
have Fast Boot disabled, insert your boot
media and start your PC. Look for a ‘Press
any key to boot from CD or DVD’ option
(even if you’ve booted from a USB Áash
drive) – press the key and you should Ànd
the Windows install process starts.

2

TZHDNERRWRSWLRQV

If you boot back into Windows,
restart your PC again, but this time press a
key, such as [F11], when prompted to
open a boot menu. Do so, select your
boot media (choose UEFI if the option
appears) to boot; otherwise, enter setup
to change boot device order.

3

WLQGRZV

If Fast Boot is enabled, open
Settings in Windows and navigate to
‘Update and recovery’ > Recovery, then
click ‘Restart now’ under ‘Advanced
start-up’. When the boot options appear,
choose ‘Use a device’ to select your USB
Áash drive or DVD from the list.
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Other reinstall options

Get the lowdown on three further techniques: reinstall from a recovery
SDUWLWLRQGRZQJUDGH:LQGRZVDQGVHWXSDGXDOERRWV\VWHP

S

o far, we’ve covered both
traditional reinstall
techniques, but there are
other reasons – and
methods – for
reinstalling Windows.
First up is the recovery option. Most prebuilt PCs come with a built-in
manufacturer’s recovery partition that
enables you to restore Windows to its
factory shipped condition. The main
advantage of this method – aside from
being cheaper and easier for the
manufacturer, of course – is that your PC
is restored to a guaranteed working
state, with all the drivers it needs to
function. The downsides are that a lot of
extra unwanted software is usually
installed alongside Windows, you need
to exercise extreme caution not to lose
everything on the drive and that if the
recovery partition corrupts – typically
due to hardware failure – you’re left
with no means of reinstalling Windows.
If you’re planning to reinstall Windows
by this method, look for a prompt to
start recovery when you ﬁrst boot
Windows or look for the option under
the ‘Advanced start-up’ menu (see
below) – consult your computer’s
documentation or manufacturer’s
website for details. Remember that most
recovery options are fully destructive, so
be sure to have backed up your system
before you begin – and that includes
creating a complete drive image.

DOWNGRADE WINDOWS

Another reason to reinstall Windows is
to revert to an earlier version. If you’re
pining for Windows 7 or 8.1, then it’s
usually possible to downgrade your
copy of Windows – remember support
for Windows 7 ends in January 2020,
and Windows 8.1 in January 2023. Before
reaching for your old Windows media,
however, you need to do some
homework ﬁrst.
First, if you upgraded your PC to
Windows 10 from an older version of

Look under the Advanced Start-up
menu for factory restore options.
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Fetch the drivers for whichever
version of Windows you install.

Windows, restoring that version should
be straightforward in the sense you can
use your manufacturer’s recovery
partition if it still holds the original
version, or you can try installing from an
old, unused copy of Windows 7 or 8.1
– just follow the guides to preparing
and reinstalling Windows earlier on in
this feature. Do source the correct
drivers for your PC ﬁrst, though, and
verify that your new software is
backwards compatible (desktop apps
should be, but Windows Store apps
won’t work in Windows 7, and some may
not work in Windows 8.1 either).

feature. Second, disable Secure Boot.
And ﬁnally, look for a CSM (Compatibility
Support Module) option and make sure
it’s enabled. All three settings need to
be made to support Windows 7 – if you
can’t ﬁnd them, consult with your PC or
motherboard manufacturer.
Once done, you should ﬁnd you’re
able to boot from your Windows 7
installation media, enabling you to
revert to the earlier copy of Windows.

SET UP A DUAL-BOOT PC

Our ﬁnal scenario is one where you
install two versions of Windows side-by-

“If you’re pining for Windows 7 or 8.1,
it’s usually possible to downgrade
your copy of Windows”
If your PC came with Windows 8.1 or
10 preinstalled, then going back to
Windows 7 will be trickier and possibly
even impossible. Before embarking on
this, check the internet to see if others
have had similar success. You’ll need to
source your own Windows 7 installation
media and valid licence, and you’ll
almost certainly need to have access to
your PC’s UEFI settings – if Fast Boot is
enabled, open Settings > ‘Update and
recovery’ and click ‘Restart now’ under
Advanced start-up. When prompted,
select Troubleshoot > Advanced
Options > UEFI Firmware Settings.
Once inside your PC’s UEFI settings
you need to locate and change three
settings. First, disable the Fast Boot
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side. This is a step for advanced users
only, and if you’re merely planning to
install an older version of Windows next
to Windows 10 for compatibility
purposes, explore alternative options,
namely setting up a virtual Windows 7
machine using a tool such as VirtualBox
(www.virtualbox.org), which runs inside
your main Windows installation.
If you are determined to dual-boot
your setup, the step-by-step guide on
the facing page covers the process of
installing an older version of Windows
alongside your current one.
Before you begin also make sure you
take a fail-safe drive image using
Macrium Reﬂect Free and be sure to
create the rescue media too.

Windows 10
Pick your perfect reinstall
Set up a dual-boot PC

1

PDUWLWLRQKDUGGULYH

3

AGGQHZ:LQGRZVSDUWLWLRQ

5

IQVWDOOQHZFRS\RI:LQGRZV

You’ll need to partition your drive to free up space on
which to store your copy of Windows. The best tool for the job is
AOMEI Partition Assistant (www.aomeitech.com/aomei-partitionassistant.html). Start by clicking Make Bootable Media under
Wizards to create rescue media.

Now select the newly created Unallocated space to the
right of drive C and click ‘Create Partition’ under Partition
Operations. Verify NTFS is the Àle system and click Advanced
to give the partition a suitably descriptive label, such as Win7
before clicking OK. Click Apply > Proceed and reboot.

Once the new partition has been created (check in
Windows), reboot using the installation media for your target
version of Windows. The install process is almost the same as for
a regular Windows installation, but be sure to choose the newly
created partition as your target during installation.

2

SKULQNPDLQSDUWLWLRQ

4

TZHDN8(),VHWWLQJV

6

PRVWLQVWDOOVWHSV

Select your Windows drive (typically C:) and click ‘Resize/
Move Partition’ under Partition Operations. Use the slider to free
up at least 30GB space to the right of the Windows partition. If
your drive is an SSD, click ‘Advanced>>’ and tick ‘Allow partition
alignment…’ Click OK.

If installing Windows 7 alongside Windows 8.1 or 10,
you may need to reboot into your UEFI (see the main text) to
enable the Compatibility Support Module (CSM), plus disable
Fast Boot and Secure Boot. Once done, you should be able to
boot successfully from Windows 7 installation media.

When Windows reboots for the Àrst time you’ll see a boot
menu appear listing the different versions of Windows you have
installed. If the 30-second delay is too long, or you want to
change the default, Click Start > Run, type ‘msconÀg’ and hit
Enter, then make changes from the Boot tab. Q
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PRINT SUBSCRIPTION
ONLY £14

DIGITAL SUBSCRIPTION
ONLY £5

Every issue delivered to your door
at a fraction of the cost

Instant digital access on your
iPad, iPhone & Android device

(Every 3 months by Direct Debit)

24

|

| September 2017

(Every 3 months by Direct Debit)

Subscribe and receive
UK subscription offer

SAVE

31%

PRINT + DIGITAL BUNDLE ONLY

£18

(Every 3 months by Direct Debit)

Q Every new issue in print and on your iPad, iPhone & Android device
Q Never miss an issue, with delivery to your door and your device

Q Huge savings, the best value for money, and a money-back guarantee
Q Instant digital access when you subscribe today

IT’S EASY TO SUBSCRIBE!
Click: myfavouritemagazines.co.uk/subwha
Call: 0344 848 2852

TERMS AND CONDITIONS Prices and savings quoted are compared to buying full priced UK print and digital issues. You will receive 13 issues in a year. You can write to us
or call us to cancel your subscription within 14 days of purchase. Your subscription is for the minimum term specified and will expire at the end of the current term. Payment
is non-refundable after the 14 day cancellation period unless exceptional circumstances apply. Your statutory rights are not affected. Prices correct at point of print and
subject to change. For full terms and conditions please visit bit.ly/magtandc. Offer ends 30/9/2017.

September 2017 |

|

25

Not your average technology website

EXPLORE NEW WORLDS OF TECHNOLOGY
GADGETS, SCIENCE, DESIGN AND MORE
Fascinating reports from the bleeding edge of tech
Innovations, culture and geek culture explored
Join the UK’s leading online tech community

www.gizmodo.co.uk

twitter.com/GizmodoUK

facebook.com/GizmodoUK

WINDOWS TIPS

INTERNET ADVICE

Welcome
In this month’s
Explore section
we’re going to
show you some
simple techniques
for making your PC more
productive and easier to use.
We kick off on page 28 by
showing you how to make any
PC start up faster; then on page
36 how you can free up storage
space by offloading some of
the bulkier files on to an
external hard drive. We also
explain how you can quickly
batch rename your holiday
snaps on page 42. And on page
48, you’ll discover how to make
the most of the enhancements
to Cortana in the recent
Creators Update.

EXCITING NEW PROJECTS

)ʅɸɗʙLVʤʖQɒ
28 How to make any PC start up
faster – it’s surprisingly easy!

50 Stop websites from tracking you
with the Ghostery plugin

32 Boost your social media profile
with these esssential Twitter tips

52 Get more from File Explorer

36 Free up space on your PC by
adding an external hard drive
38 Find out how to enhance your
photos with Aviary Photo Editor
42 Discover a quick, and safe, way
to batch rename your image files
46 Manage your computer’s
energy saver settings
48 Make the most of Cortana’s
new Creators Update features

Rob Mead-Green
Editor
rob.mead-green@futurenet.com

<ʝʦɠʔʦLȫɏ
'ʋɚ*UɪɬKʋəVʋ\ɡ

“Cortana is now easier to
use and more powerful
than ever”
7ʦʢɚWɛSDȰɏ
WɛʓʖQɍʝXɢPʝȾɏ

Our promise to you…

Get more from Windows, software and all your favourite sites

Packed with informative tutorials

Get more from your favourite websites

Every issue, we guarantee to pack the
magazine with great tutorials teaching
you all the best things you can do with your PC.
Each article features step-by-step instructions
to make learning new skills fast and enjoyable.

We all have our list of favourite sites
but often we miss out on great features
because they’re difÀcult to use or hidden from
sight. We’ll show you how to do more online,
for a more satisfying web life.

Customise Windows to work your way

Discover new programs with our help

We all know how to do the basics but
getting the most from Windows isn’t
always easy. Our dedication to the operating
system means you get the very best tips and
tricks for all versions of Windows.

From speed-up and security software
to superb photo apps, there’s always
something new to try on your PC. The
Windows Store in Windows 10 and Windows
8.1 is packed with software to download.
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/HʋʢɚKʝɦWɛ

Make your PC
start up faster

FAST START-UP
This is a little like
Hibernate mode. It
caches your current
Windows session so
that it can be
reloaded quickly.

<ʝʦɠʔʦLȫɏ&Dɢ(ɸʙLɡVʋ\ɡ

“Don’t sit around waiting for
Windows 10 – here are some tips
for making it boot more quickly”

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1
Windows 7

O

ver time you might notice
that the delay between you
pressing your PC’s power
button and having a responsive
desktop is getting longer and longer.
It can be enormously frustrating,
particularly when you need to get
stuck into some important work. You
might even be tempted to just leave
it switched on all the time, but this
means important Windows updates
won’t be installed. Thankfully there
are ways to speed your PC up again.
We’ll explore several methods here,
but it’s also worth noting some of the
things that won’t have an eﬀect –
despite claims by the makers of some
PC optimisation software. Windows
10 does a good job of managing your
hard drive, so defragging it is unlikely
to have any eﬀect on performance.
Similarly, deleting temporary ﬁles,
uninstalling programs and tidying the
Windows registry won’t have a
noticeable impact. Here’s what will…

BOOT TIME
You can use
Windows’ own logs
or a program like
Bootracer to ﬁnd out
how long it takes
Windows to start.

Step-by-step Make your PC boot faster

your startup time
1 Find
First, type ‘Event Viewer’ into the Search bar, then doubleclick ‘Applications and Service Logs’ > Microsoft > Windows >
Diagnostics-Performance. Right-click the log named Operational,
click Open and scroll down the list until you see an event with the
ID 100. Click this and look in the small pane below to see the boot
duration in milliseconds. Make a note of it – we’re going to cut it!
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the Task Manager
2 Use
When Windows starts, several other programs start up at
the same time. Many are necessary for your PC to work correctly,
but others are things you don’t necessarily need immediately, and
can be started later if you decide you want to use them. To see
which programs start at the same time as Windows, you can use
the Task Manager. Tap [Ctrl] + [Shift] + [Esc] to see it.

Explore
Make your PC start faster
LOGON
Selecting this tab
will show only the
app and programs
that run when you
log into your
Microsoft account.

AUTORUN
This Microsoft app is
the most powerful
tool for managing
the programs that
start at the same
time as Windows.

Jargon buster!
Boot
To load the
operating system (in
this case, Windows
10) into RAM, so it’s
ready to use.
Driver
Software that
controls a piece of
hardware (whether
it’s internal like a
sound card, or
external like a printer
or display.

ENABLE OR DISABLE
To stop a program
running when
Windows starts, just
uncheck its tick box.
You can always
re-enable it later.

SSD
Solid-state drive –
a kind of storage
device with no
moving parts. They
are faster, quieter
and more robust
than spinning hard
disks, but are more
expensive per GB of
storage space.

PUBLISHER AND
DESCRIPTION
This will help you
work out what each
app does, but if
you’re not certain,
leave it alone.

startup programs
3 Check
When the Task Manager opens, you’ll see a list of all the
apps and processes that are currently running on your PC. Click
the Startup tab at the top and take a look through the list of
programs that start at the same time as Windows. You’ll probably
see drivers that relate to your graphics card, printer and other
devices, along with other applications you don’t recognise.

ȉ$76%Ǌ67ƼǏ3
ǽǜ'ɡʋȾɏIDVɀʑɠʡʦȲHɀʑɠʋQɍ
ʢʦɚFRɼȵʑɠʃKʋɚʤUDʏLʤLʝQɪɗ
KʋUɍʏLʂɖʏʢʖɃHɡ7ȱʑɨȾɏ
ɭȱHʋȼʑɠWɛʍʦɨQʝɦWRɛ

unnecessary apps
4 Disable
What you’re looking for are programs that you’ve installed
yourself and don’t use every day. Here, there’s a program called
Steam Client Bootstrapper that launches the Steam game
platform. To stop a program like this running every time you start
your PC, right-click it and select Disable. If you change your mind
later, you can always re-enable it via the Task Manager.
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a closer look
5 Get
If you know there are other programs starting with

and save
6 Disable
You’ll now see a huge list of programs and processes. As

Windows, but you can’t see them in the Task Manager, you need
Autoruns. This little program from Microsoft identifies many more
startup programs, including Windows applications. Download it
free from http://bit.ly/1zJJKYU, extract the ZIP archive and
double-click the file Autoruns.exe.

before, you’re looking for programs you recognise and know you
don’t need immediately. Click the Logon tab and uncheck the box
beside anything you want to disable. You might be prompted to
give administrator permission before you can change anything.
When you’re finished, click Save and close Autoruns.

Fast Start-Up
7 Enable
Fast Start-Up is a new tool introduced in the Windows 10

Windows
8 Reset
If your PC is taking several minutes to boot, it’s time to reset

Anniversary Update, and works a little like Hibernate, saving your
Windows session in a temporary file that can be loaded quickly
when the PC is turned on again. To make sure it’s enabled, type
‘Power Options’ into the Search bar, click ‘Choose what the power
buttons do’ and check the box marked ‘Turn on Fast Start-Up’.

to an SSD
9 Upgrade
If you have Windows installed on a hard disk drive,
upgrading it to a solid-state drive (SSD) can have a tremendous
effect on boot times. You can still keep your files and other
programs on the old disk. Unfortunately you can’t just transfer
Windows across with a few clicks – you’ll need to reinstall it on the
new SSD. Microsoft has a handy guide here: http://bit.ly/2tZkZb3
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Windows. Type ‘Reset’ into the Search bar, select ‘Reset this PC’
and click ‘Get started’. You now have three options: Keep My Files;
Remove Everything; and Restore Factory Settings. Select the first
option – it will reinstall Windows and remove any other apps, but
will let you keep your files (it’s a good idea to back them up first).

the results
10 See
Once you’ve finished, shut down your PC, power it back on
and check your startup time again. Hopefully you’ve managed to
cut the time significantly! You might want to consider using a
third-party app like BootRacer (www.greatis.com/bootracer). This
tells you how long the boot process takes, and how long it takes
for Windows to be ready to use after you’ve logged in. Q
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Use Twitter
like a pro
<ʝʦɠʔʦLȫɏ$ȵʑɧ%OɪȴɏVʋ\ɡ

“Twitter is a hugely powerful tool
– here, we’re going to show you
how to make the most of it”

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1
Windows 7

W

hether you run a website or
your own business, you’ve
probably heard ‘experts’ and
‘gurus’ telling you that you need to
get on Twitter and start promoting
your work. And you’ve probably also
tried it yourself. But how do you go
from a lonely echo chamber with no
followers to having a thriving online
community willing to share your
posts and promote you to others?
Despite appearances, it’s not rocket
science. With some careful planning,
attention to detail and a bit of
patience, you can build your Twitter
presence into an invaluable tool for
your business or blog.
If you’ve found if diﬃcult so far,
don’t be discouraged. It can take time
to go from zero to hero on Twitter,
but the beneﬁts of an engaged
audience far outweigh the
drawbacks. So let’s get stuck in and
we’ll help you become a true social
media specialist…

Step-by-step Increase your reach on Twitter

28 DAY SUMMARY
An overview of how
many tweets you
made, the number
of impressions your
tweets got, proﬁle
visits and more.
TOP TWEET
Your most popular
recent tweet. Keep
an eye on this; if a
trend emerges, use
it to post similar
content in future.

VIEW ALL
TWEET ACTIVITY
See a breakdown of
your tweets and the
engagement they
got in more detail,
over time.
TOP FOLLOWER
The most popular
follower you gained
in recent weeks.
These often make
good candidates for
future collaboration.

engagement
1 Encourage
It can be discouraging to post something on Twitter and be

connections
2 Make
Famous friends can be useful, but how do you get them?

greeted with silence. If that sounds familiar, you may be posting
the wrong sort of content. The best way to get engagement is
often the simplest: ask your readers a question. What did they
think of the Champions League final? Did that contestant deserve
to win Bake Off? Give people a chance to share their opinions.

The best way is to offer them something of value. Find the key
players in your genre and offer to write for them, or suggest a
partnership. Even something as simple as a compliment on their
work can help. Make yourself known to them and offer value, and
they might share your work; you’ll reap the benefits.
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Explore
Use Twitter like a pro
Jargon buster!
Retweet
This is when
someone shares one
of your posts with
their own audience.
Hashtag
Used to deﬁne topics
within your Twitter
posts, such as
#football, #politics,
#Rihanna, etc.

TOP MENTION
Being mentioned by
others is important
since it exposes you
to their audience.
Mentioning others
helps you too.

TOP MEDIA TWEET
Twitter is a visual
medium, so posting
images or videos
can increase your
reach. This shows
what’s worked.

similar accounts
3 Tag
Got something worth sharing? Twitter lets you tag people in
your pictures, and if you’re smart you can really boost your reach.
Tag similar accounts (that you’ve already connected with) in your
images and they’ll get notified. If they like it, they might retweet
it, exposing you to another set of eyes. Don’t overdo it, and only
tag accounts you know to avoid seeming spammy.

DM
Direct Message. Use
it to privately talk to
other Twitter users
without the general
public seeing any of
your messages.

Ǆ/Ǌ;6%Ǌ67ƼǏ3
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ʍXɢȴȭʑɞZʝʁʘʖQɒʋQɍ\ʝɤɸɗ
ȾHʋɞʃȱɏȾʑZʋUGɡ

use of lists
4 Make
Lists are a great way to get more organised. Twitter lets you
create groups of accounts that you can sort by topic. You might
create a list of inspirational accounts that you can learn from, for
instance, or a list of accounts that you’ve shortlisted for future
collaboration. Browsing each list only shows tweets from the
accounts within that group, which helps keep you focused.
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the data
5 Study
Whether it’s on social or anything else in life, data can really
help to inform your decisions. Twitter provides a dashboard of
stats for you to browse – your most popular posts, the most
prominent time you were mentioned by another account, how
engaged your readers are, and more. Use this data to see what
works best, work out the trends, then keep doing more of that.

your posts
7 Schedule
It could be that most of your audience is based in another
time zone, which makes posting at the optimal time somewhat
unsociable for you. To get around that, take what you’ve learned
from Steps 5 and 6, and then use tools such as Hootsuite or Buffer
to schedule your posts. That way, Twitter will keep posting your
content even when you’re away from your PC or phone.

consistent
9 Be
One of the best things you can do for your audience is to be
reliable. If you have some killer content that you post regularly
– like a series of blog entries, for example – make sure you have a
regular slot to post them on Twitter. That way, your audience will
know when to keep coming back – a returning audience is more
likely to gain an affinity for you, and help share your content.
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your audience
6 Know
Whenever you’re writing for an audience, you need to know
them inside out. One lesson you can learn from your Twitter data
is when most of your audience is online. Use tools like Tweriod or
Followerwonk to find that out, then make sure you post at those
times to maximise the number of people who will see your posts.
There’s no point posting when your audience is asleep.

dimension
8 Another
There’s no point posting an image on Twitter, only to find
the most important bit has been cropped out. Make sure you
learn what size and dimensions to use for your images so there’s
minimal cropping (Twitter sometimes changes these dimensions).
The aim is to make life easy for your readers – if they can’t see
what an image shows right away, they’re likely to just move on.

with ads
10 Promote
There is one sure-fire way to increase your reach – promote
your posts with adverts. Since this involves parting with cash,
make sure you research what techniques work best, what your
audience responds well to, and when to post. This can be useful if
you use the ad to drive readers to your website. This is a good
option if you need to promote your content to a wide audience. Q
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Add an external
drive to your PC
<ʝʦɠʔʦLȫɏ,ʋɚ(ɃʑQȫʑɚVʋ\ɡ

“Expanding your PC’s storage with an external hard
drive is quick and easy, and can make a real
difference to the way you work”

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1
Windows 7

E

xternal storage is pretty
cheap at the moment, so if
your PC’s internal hard drive
– or SSD – is groaning at the seams
with accumulated documents,
photos and video ﬁles, why not
oﬄoad it to an external drive?
While emptying your internal drive
on its own won’t speed up your
computer, it can have many knock-on
eﬀects that make it appear like it has
– things like ﬁle indexing taking less
time, which frees up your processor
for other tasks, or virus scanning
being completed more quickly.
Once, there were many ways you
could attach a new drive to your PC,
but these days the USB socket is king
– the blue USB 3.0 sockets being
noticeably faster than their USB 2.0
predecessors. If you have a new,
powerful laptop, you may have
smaller USB-C ports, but these aren’t
found on PCs very often yet, and
adapters are easily available.

ƮǄ16%Ǌ67ƼǏ3
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ʋɚǽǜ'7ȱʑɨFRVɢPʝȾɏ ʍXɢ
ʃȱɏʣȼȭHɍʖQʎȾHDȿɏLɡʕXȰɏ 

Step-by-step Expand your computer’s storage

it in
1 Plug
Some USB hard drives are powered by the USB plug itself,

the format
2 Check
Drives are generally sold ready-formatted, so you can start

while others need a separate power adapter. If yours is one of the
latter, plug in the power before connecting it to your PC. The drive
should be recognised immediately, and pop up in File Explorer.
Connecting a USB 3.0 drive to a USB 2.0 port will still work, but
you’ll be limited to USB 2.0 speeds.

using them immediately. You may want to reformat the drive,
however, depending on what you want to do with it. If you’re
using a drive with a couple of terabytes of storage on it, the best
format for using with Windows is NTFS. Many drives are formatted
this way out of the box, but you can change it if you want to.
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Explore
Add an external drive

3 Reformat
Most computers, including Apple ones, can at least read
NTFS-formatted drives even if they can’t necessarily write to them.
If you want to use the drive to exchange data with a computer
that uses a different operating system, consider reformatting to
exFAT, as this can be read and written by a large range of systems,
including games consoles.

did my space go?
5 Where
You may have bought a 4TB drive, but in Windows you’ll

careful
4 Be
To format a drive in Windows, right-click its icon in File
Explorer, and select Format from the menu. Formatting destroys
all the information on a drive, so be sure to use it on either a blank
new drive, or one you’re certain contains no data of value or
anything you need. Once you’ve selected Format, you can choose
the file system it will use, such as NTFS or exFAT, then click Start.

ReFS?
6 What’s
Windows 10 may ask to format your drive using the ReFS file

only get around 3.6TB of usable space. This is because of a
difference in the way hard drive manufacturers and your PC
calculate capacity. Makers assume 1,000 megabytes in a gigabyte,
while your PC uses a more accurate 1,024. The difference between
these figures accounts for the ‘missing’ space.

system, introduced in Windows Server 2012 as a replacement for
NTFS. For most home uses it makes no difference to the way your
drive works – it’s designed to handle eye-wateringly large files we
just don’t produce yet. As ReFS is new, it may not be supported by
all machines or programs, so it’s probably best to stick with NTFS.

7 Backup
For security, you can use Windows’ File History tool to start

I encrypt it?
8 Can
Not with Windows 10 Home Edition. If you’re running Pro or

backing up your files to the new drive – just choose it as a target
in the main File History window. If you want to clear space on
your internal drive, the easiest way is to copy the folders that are
taking up lots of space, such as Pictures or Videos, over to the new
drive, deleting the originals when the copying process is finished.

Enterprise editions of Windows and your PC has a TPM chip, you
can use BitLocker (http://bit.ly/2tmkmrx) to encrypt the drive.
Third-party encryption programs are available from brands such
as Symantec or Sophos, so you can protect your data behind a
password in case you lose your drive, or it’s stolen. Q
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Master Aviary
Photo Editor
<ʝʦɠʔʦLȫɏ,ʋɚ(ɃʑQȫʑɚVʋ\ɡ

“If you can Ànd it, this is one of the
best free photo editing apps on
the Windows Store”

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1

Windows 7

the app
1 Find
Due to its generic name, this isn’t the easiest app to find.
Search for Photo Editor and it should be fairly high up in the
results and can be recognised by its blue, pink and green icon.
The developer is Aviary Inc, but searching the Store for ‘Aviary’
doesn’t get you anything. Once you manage to track it down on
the Windows Store, click the blue button to install it.
|

YOUR IMAGE
Taking up the bulk
of the window, your
image can’t be
zoomed into, so be
sure to display it as
large as possible.

A

viary has an interesting
history. Founded in 2007, the
company aimed to supply
photo editing for free. It popped up
on the Flickr photo sharing website,
allowing you to edit your uploaded
photos and save them back to your
photostream. The company attracted
a great deal of investment, and then
in 2014 it was bought by industry
giant Adobe, which has been busy
integrating its tools into the Creative
Cloud suite of applications. As it’s
now part of Adobe’s software
development kit, anyone can add its
abilities to their programs.
There is a ‘pure’ form of Aviary,
however, available both on the
Windows Store and as a mobile app.
Confusingly, it’s just called Photo
Editor – the ‘powered by Aviary’ line
only appears once the app is running
– but it can be identiﬁed on the Store
by the name of its developer: Aviary
Inc. Let’s take a look…

Step-by-step Make your photos pop

38

BACK BUTTON
Click this at any time
to cancel what you
are currently doing
and head back out
to the previous
Photo Editor screen.

| September 2017

AUTO TOOLS
Tools to the left of
the toolbar are the
more automatic
ones. Look here for
one-shot ﬁxes and
photo ﬁlters.

an image
2 Open
When you first launch the app, you’ll see the image files it’s
found on your hard drive, along with some photos of its own.
Click the Browse button to open a File Explorer window and
search your image library for the file you want to work on. Open
it, and the interface changes to display the editing tools. You can
return to this screen at any time using the back arrow.

Explore
Master Aviary Photo Editor
FULLSCREEN
This button by
Minimise and
Maximise puts the
app into fullscreen
mode, where the
top bar is hidden.

Jargon buster!
PNG
Portable Network
Graphics. A type of
image ﬁle that uses
lossless compression
to strike a balance
between small ﬁle
sizes and high
quality images.
DONE
Press this to ﬁnish
editing. A PNG ﬁle of
your adjusted image
will be placed in the
Pictures/Aviary
Photos folder.

Compression
Methods to make a
ﬁle smaller. Lossy
compression throws
away data, and while
it can compress
eﬀectively, it can
aﬀect image quality.
JPEG
The most common
image ﬁle format.
JPEG uses lossy
compression, and at
higher compression
ratios image quality
can suﬀer.
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MANUAL TOOLS
The tools at the right
are those that need
more input from
you, such as
choosing a brush
size or a colour.

3 Enhance
The first tool along the bottom is Enhance. It has four
options that are clicked on or off. The first, Auto, is an attempt at a
one-tool-for-all approach to editing, and boosts the colour and
contrast in your image. Night is for images taken in the dark, but
has interesting effects on any photo, Backlit attempts to lighten
foreground objects, and Balance has a go at colour correction.

and Stickers
4 Effects
These are one-click filters, plus amusing stickers to place
over images. There’s a limited range, and many of the stickers are
designed to be placed over pictures of people. The Effects can be
interesting, with a nice black-and-white in Metropolis or the
colour saturation boost of Dean. All edits you make have to be
applied using the button at the top right before you move on.
September 2017 |
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and Crop
5 Orientation
These affect the angle and shape of your photo. Orientation

Contrast, Saturation, Sharpness
6 Brightness,
These affect the look of your photo. There’s no colour

allows you to rotate your image through 90-degrees in either
direction, or flip it horizontally or vertically to get a mirror image.
Cropping allows you to remove the edges of the image to focus in
on the main subject, or to make it fit a particular size – there are
presets along the bottom, or you can drag with the mouse.

balance tool, so your only option if you’re working with a file
that’s very yellow is the Balance option under Enhance. These
tools work simply, with a single slider each and an Apply button.
It’s possible to ruin your image with these tools, so make sure you
don’t apply the effect too strongly.

and Drawing
7 Text
These allow you to add text and your own drawings to your

and Whiten
8 Redeye
These tools are aimed at touching up portraits. The Redeye

image. It can be used to add headings or messages, and your text
can be scaled and coloured, but always runs in a straight line.
Drawing gives you a choice of brush sizes and colours – it’s better
suited to a pen input on a touchscreen device, since drawing with
a mouse can be a hit-and-miss affair as the pointer wobbles.

effect is less common these days, but occurs when a camera flash
is too close to the lens axis. It lights up blood vessels in the back
of the eye, giving an eerie, werewolf-like appearance to the
victim’s eyes. It can be removed with a simple click here. Whiten is
aimed at the teeth, taking away any yellow colour cast.

9 Blemish
The Blemish brush is also aimed at cosmetic improvements.

10 Saving
There’s no explicit Save button in Aviary, images are saved

It’s a spot removal brush similar to the Spot Healing brush in
Photoshop, and will smooth over skin imperfections you click on,
such as acne or scars. It tends to blur a lot, especially if used over a
large area, and its use isn’t helped by the app’s lack of a zoom
feature, meaning you always have to work on the entire image.

to your PC when you hit the Done button. No matter where you
opened the image file from, your edited image goes into an
Aviary Photos folder within your Pictures folder. It’s always a PNG
too, even if the original file was a JPEG – the app won’t save over
your original image file and you’ll always have it to edit again. Q
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Rename your
photos quickly

EDIT SELECTION
FILTER
Click here to set a
ﬁlename-based ﬁlter
so only photos that
match certain names
are selected.

<ʝʦɠʔʦLȫɏ1Lɭɖ3ȭʑUɡVʋ\ɡ

“Use PhotoRenamer to give your
photos more descriptive Àlenames
with the minimum of effort”

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1
Windows 7

H

ow many times have you
told yourself you’re going to
ﬁnally go through the
hundreds of digital photos you’ve
taken and rename them in such a
way they’re easy to go through?
Thanks to PhotoRenamer, you no
longer have to put up with
incomprehensible ﬁlenames, and
instead name your photos in such a
way as to help you more easily
recognise and organise them.
PhotoRenamer works by applying
special user-deﬁned masks to your
ﬁlenames, making it easy to rename
them with keywords, counters and
even the date and time they were
taken (if that information is recorded
in the ﬁle’s EXIF metadata). And if
you’re worried about making a
mistake, PhotoRenamer provides a
full preview of what your ﬁles will be
called, plus oﬀers options whereby
your original ﬁles (and their names)
can be preserved, just in case.

FOLDERS
SELECTION
Click here to select
your photos folder.
Files can be selected
manually or by using
the selection ﬁlter.

Step-by-step Batch rename your photos

PhotoRenamer
1 Get
Visit www.tgmdev.be and click the ‘PhotoRenamer 4.0b’ link
under ‘Windows Utilities’ followed by ‘Download PhotoRenamer
4.0b’ from the Quick menu on the left. Leave the fields blank and
click ‘Start Download…’ Save the setup file to your PC, then
double-click it and follow the prompts to install PhotoRenamer.
Once complete, leave the box ticked and click Finish.
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source folder
2 Select
After launching, a pop-up menu provides access to several
videos explaining how the program works. Click OK to close this
window and access the main screen proper. First, use the Folder
Selections pane on the left to browse to and select the folder
containing the first set of photos you wish to rename. When you
select a folder with photos, wait while it generates thumbnails.

Explore
Batch rename your photos

FILE RENAMING
MASK
Where ﬁlenames are
changed. Use the
mask to select the
elements that make
up the new names.

RENAME TYPE
Three options here
– the ﬁrst two are in
our guide. Target
Rename will copy
renamed ﬁles to a
new folder.

Jargon buster!
EXIF metadata
A standard form of
metadata – or tags
– that are applied to
photos, such as
when and where a
photo was taken.
Mask
Special ﬁlters –
preceded by the %
character – that tell
PhotoRenamer to
rename a ﬁle using
certain information,
a date or time stamp
for example.

EDIT KEYWORDS
Click here to add
keywords to a
database that you
can subsequently
add to your ﬁle
renaming masks.

Batch processing
A job that performs a
series of repetitive
tasks – such as
renaming ﬁles – on a
group of objects
– often ﬁles –
without you having
to intervene.

FILE NAME PREVIEW
Use this panel to
select ﬁles [Ctrl]-click
to select multiple
ﬁles). You can also
review the proposed
new ﬁle names.
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rename path
3 Change
You’ll see a list of photos appear in the main pane. Pay
attention to the Renamed File Name column – this tells you what
the new filenames will be. If you want to err on the side of
caution, tick the Backup Rename box under Files Handling on the
ribbon. By default, the originals will be stored in a Backup folder
inside the current folder. Click Browse to change this.

naming convention
4 Choose
PhotoRenamer can rename your files in several ways using
masks. The default mask renames the photo according to the
date and time stamp recorded in its EXIF metadata. The default
mask names things in such a way that the files will be sorted
oldest first. To create your own mask, click the Edit Mask List
button. Select the first entry in the list and click Edit Mask.
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up new mask
5 Set
Masks are created from existing ones. Start by clearing the

mask
6 Build
Click ‘Add Format Specification’ to add a second mask, and

Renaming Mask box and clicking Add Format Specification. You’ll
see an extensive list of options, from keywords and counters to a
wider range of date masks (both fully formed – such as %DT2 –
and individual elements, such as %b for an abbreviated month
name). Click ‘Select Format Specification’ to add it to the mask.

any subsequent masks, to your file. If you select %KI (keyword
entry), you’ll be prompted to add a keyword to the name of your
selected files – ‘holiday’, for example, – when you come to rename
them. Remember to add separators (typically dashes, underscores
or spaces) between each mask to make filenames easier to read.

new mask
7 Apply
Use the File Renaming Preview panel to see how your mask

your keywords
8 Select
Click ‘Exit and Use Renaming Mask’. If you chose the %KI

will affect the names of your files. You can manually remove and
add characters too – for example, you could substitute %KI with
actual text, such as ‘France’. When you’re happy, give your mask a
name using the Mask Description field, click ‘Add Renaming Mask
to Database’ followed by ‘Exit and use Renaming Mask’.

option, you’ll be asked to enter your choice of keyword or phrase
for the first photo. Rotate the image preview if necessary, then
click OK to move on to the next. Previously entered keywords can
be chosen from the list, or tick ‘Apply the Same Keyboard Entry…’
if the remaining photos will share the same keyword.

and rename
9 Review
Check the ‘Renamed File Name’ field for each photo you’ve

photos, renamed
10 Your
If you chose the backup option, you’ll find that your original

selected – if any are incorrect, right-click their entry in the list and
choose Edit Applied Mask Data. Click the incorrect mask to open
the editing tool – for example, the keyword editor – and make
your change. Once you’re happy, click Rename All Files or – if
you’re selected a group of files – Rename Selected Files.

files have been copied to the backup location, while newly named
files have replaced them. If you’re happy with the renaming,
delete the originals, then move on to the next folder (if your mask
contains %KI, you’ll be prompted to add keywords). Once that’s
done, your photos will be easier to recognise and organise. Q
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Control your PC’s
power usage
<ʝʦɠʔʦLȫɏ,ʋɚ(ɃʑQȫʑɚVʋ\ɡ

“If you don’t need your PC to run at full power all the
time, you can control how much energy that it uses”

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1
Windows 7

M

odern PCs can use a lot of
electricity. The power supply
in a desktop can potentially
draw over a kilowatt, especially if the
PC was built with gaming or 4K video
editing in mind. You don’t need that
if you’re surﬁng the web or preparing
a few word processing documents,
however, and that’s where Windows’
power management options come in.
Laptops use less power than
desktops, but when on the move you
need to conserve your battery life,
and power saving can help. Not only
can you specify when your PC will go
to sleep, or hibernate, but you can
also dig deep into the settings to
restrict your processor’s maximum
frequency or when your hard drives
stop spinning to save power.
If that sounds a bit technical,
Windows already has some power
plans built in, so you can easily switch
between high performance and
power saving with just a few clicks.
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Step-by-step Take the power back

Power & Sleep Settings
1 Use
In Windows 10, pop up the Start menu and type ‘power’, and
look for Power & Sleep Settings in System Settings. Click on this,
and a window will appear allowing you to alter the settings.
Choose how long you’d like to leave your PC idle before it goes to
sleep or turns its screen off. If you have a laptop, you can have
different settings for battery power or when plugged in.
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power settings
2 Additional
Click the ‘Additional power settings’ link to be taken to the
Power Options window. Here, you can choose between Windows’
preset power plans: Balanced, ‘High performance’ and ‘Power
saver’. If you’re playing games or editing video, you’ll want ‘High
performance’. If you’re trying to eke out every last bit of battery
life, choose ‘Power saver’. Most people should choose Balanced.

Explore
Control your PC’s power usage

power settings
3 Advanced
Click ‘Change plan settings’ on any plan to be taken to a new
screen, then click ‘Change advanced power settings’. An options
window will appear. The most interesting items here are probably
‘Power buttons’ and ‘lid’ which changes what the PC does when its
power button is pressed or its lid is closed. ‘Multimedia settings’
lets you set the level of processing power used for video playback.

Windows 7
5 In
If you’re still using Windows 7, you’ll find it has a similar
approach to power management, but the settings for it are in a
different place. You’ll find the options in Control Panel > Hardware
and Sound > Power Options, or you can search for ‘power
settings’. You’ll see the same three power plans as Windows 10,
and you can click through to the ‘Advanced settings’ window too.

your plan
7 Create
At the left of the Power options window in Windows 10
you’ll see a link marked ‘Create a power plan’. Click it, and you’ll be
asked to select one of the three existing plans to use as a
template, and to give your new plan a name. Click Next, and the
display off/PC sleep time drop-downs appear, so you can choose
how long your PC will stay on. Hit ‘Create’ to save your new plan.

power management
4 Processor
You can also tinker with the settings for your processor’s
power management. Intel and AMD make a lot of their CPUs’
ability to manage their own speeds and power consumption, so
only do this if you know what you’re doing. If you do, you can set
the maximum processor frequency and change other settings
from the ‘Advanced settings’ window. Proceed with caution.

plan
6 Custom
If any of the three built-in plans aren’t to your taste, you can
either change them or create a new one. To change existing plans,
use the ‘Change plan settings’ link to the right of the plans in the
Power Options window. Your choices are limited to screen
timeout and how long it takes for the computer to enter sleep
mode, unless you want to tinker with the Advanced settings.

defaults
8 Restore
You can tinker with any of the power plans, and make some
deep changes using the Advanced settings, but there’s always a
way back, whether you’ve been fiddling with a built-in plan or a
custom one. At the bottom of the Edit Plan Settings window
there’s a link marked ‘Restore default settings for this plan’.
Clicking it does exactly what you’d expect. Q
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Do even more
with Cortana
<ʝʦɠʔʦLȫɏ'ʋɚ*UɪɬKʋəVʋ\ɡ

“It’s even easier to get help from
Cortana, thanks to the latest
Windows 10 Creators Update”

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1
Windows 7

NOW HEAR THIS
Cortana is listening.
Say ‘Hey Cortana’ to
let it know what
you’d like it to do.
You can also use the
search box too.

W

indows 10 is constantly
evolving. The Creators
Update has now rolled out
to most PCs and we’ve got another
Fall/Autumn update arriving later in
the year. As part of this, Cortana is
also changing as new features are
added and others improved. One
thing is for sure – Cortana is here to
stay. It even has a promoted role as
you set up new devices; Cortana now
helps you with the setup.
You will need to be running the
latest version of Windows 10 to use
many of these features and some
others are rolling out as 2017 goes on
(not all languages are being rolled
out together, as we’ll explain). To
make sure you have the Creators
Update installed, go to Settings >
System > About. Your Windows 10
version number needs to be 1703 or
later. Not got it? Then go to http://bit.
ly/2vaWuuR to download it. So let’s
take a look at what’s new…

Step-by-step Check out Cortana’s new features

Cortana access
1 Give
Cortana relies on access to your personal information.
Without this, it’s just another way to search for your files and the
web, and can’t offer you personalised results. You need to give it
permission to access your location, browsing history (Microsoft
Edge only) and search history. You can tweak the information that
Cortana collects in Settings (the gear icon in the left menu bar).
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screen access
2 Lock
Cortana can now be accessed from the lock screen so you
can say ‘Hey Cortana’ and let the assistant invoke automatically
without even touching your PC. You can turn this on in Cortana’s
Settings, and opt to let Cortana have access to your calendar and
email while it’s at it. Remember: because your PC is locked, this
could give someone unauthorised access to basic personal info.

Explore
Do even more with Cortana
Jargon buster!

MORE MUSIC
Cortana now works
with other music
apps such as TuneIn
Radio. See the music
icon in the top-right
of the menu.

CORTANA TIPS
You can click on one
of these tips to get
started with some
well-known queries
around weather and
basic conversions.

Virtual assistant
Cortana is one of a
new band of digital
helpers that use your
personal information
to give you relevant,
contextual answers
to queries. Siri, Alexa
and Google Assistant
are other examples.

NOTIFICATION
CHANGES
Cortana groups
notiﬁcations, plus
the notiﬁcation text
is now shown in a
larger font, too.

Natural language
A language which
has evolved naturally
without planning. It’s
what enables you to
talk to Cortana.
Lock screen
The ‘splash’ screen
that appears before
you enter your
password. You can
now use Cortana
from it directly.

OTHER TIPS
In case you haven’t
noticed already,
Windows 10 pops
Cortana tips into the
Action Centre –
check them out!

SEARCH BUTTONS
Click one of the
Search buttons here
to tell Cortana that
you want to search
Apps, Documents,
or the Web.

searches
3 Improved
One area that Cortana wasn’t that good at, initially, was
searching, especially for Cortana’s own settings. This has improved
in the latest update. Web searches in Cortana have also got better,
and Cortana now has SafeSearch settings so that there’s no
chance of anybody accessing web content that they shouldn’t
– there’s a Strict setting in addition to a Moderate option.
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improvements
4 Reminder
Also improved in Cortana is the assistant’s ability to set
reminders. You can now choose to repeat reminders, for example,
on a particular day every week, or maybe every day. We think
there should be some checkbox options here, too, so you can
easily select required days (like Tuesday or Thursday). However,
the initial setup of reminders works really well.
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to texts on your phone
5 Reply
One of Cortana’s most exciting 2017 features is the ability to
reply to text messages from your PC. Third-party apps, such as
Pushbullet, have enabled this for a while, but it’s great to have the
ability to do it natively on iOS and Android. All you need to do is
to enter your phone number, download the Cortana app (or
access it via your preferred app store) and follow the instructions.

up where I left off
7 Pick
Another exciting feature, ‘Pick up where I left off’ enables
you to do just that, but on another Windows device. To get it
working, go to the Cortana Notebook (the second icon down in
the left sidebar) and scroll down until you see the option shown
here. Don’t see it? Change Cortana’s language to US English in
Settings (this won’t change your main Windows language).

to Cortana
6 Shortcut
You can also now invoke Cortana via a keyboard shortcut,
[Win] + [C]. A setting toggles this on and off in case you don’t
want to activate it accidentally. Many users won’t find this so
useful, but if you’re a sucker for keyboard shortcuts we reckon
you’ll love this one as you can get Cortana working for you
without having to touch the mouse.

it on
8 Turn
You’ll then need to enable this setting. At the time of
writing, ‘Pick up where I left off’ was only available for Windows 10
PCs where the Cortana language – or main display language in
Windows Settings > Time & Language – is set to US English.
However, by the time you read this, it may well be available in UK
English, so check it out and see how you get on!

notifications
9 Enable
You need to enable something else in Cortana’s Settings to

and searches
10 Devices
You can also improve Cortana’s search results using the ‘My

make this work: the ability to send notifications and information
between devices. That’s because ‘Pick up where I left off’ sends a
notification to other Windows 10 PCs you’re signed into. This
shows things like tabs in Edge that you’re looking at on another
PC. Clicking the notification lets you to pick up… you get the idea.

device history’ and ‘My search history’ settings. These improve
searches because they co-ordinate apps you’ve set up and things
you’ve searched for on all your devices. Cortana works best when
you give it full access to your stuff, but these settings stop items
on specific devices from being used by Cortana if you wish. Q
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Stop websites
tracking you
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Discover how to use the Ghostery
browser extension and protect
your privacy when surÀng online

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1
Windows 7

M

any websites you visit are
tracking you through placing
small ﬁles named ‘cookies’
on your computer. This helps them
gather information about your
browsing habits and target you with
adverts. Data collection tools (known
as ‘trackers') can be very intrusive. If
you wanted a quote for life assurance
for instance, would you want an
insurance website to know that you’d
been browsing books on Amazon
about quitting smoking?
Luckily, a Microsoft Edge browser
extension called Ghostery can help
stop you from being tracked online,
blocking communications with such
companies while still enabling you to
surf the web. Better yet, it displays a
handy purple list of companies that
have tried to track you, as well as
what information they’re after. Install
it today to make sure your web
history stays private and keep
monitoring it regularly.

Step-by-step Install Ghostery

Windows 10
1 Update
Ghostery needs the most recent version of Windows to
work. Save and close any open files and back up your data if
possible. Next, click the search button at the bottom left of your
desktop then enter Windows 10 Upgrade Assistant. Click on the
desktop app to open. Click Yes to confirm that you wish to open
the app, then Update Now to begin upgrading your system.
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the Ghostery website
2 Visit
Once the update is complete, open Microsoft Edge and visit
www.ghostery.org. Hover your mouse over Our Solutions and
click on Ghostery Browser Extension. A new screen will appear
listing various web browsers. Scroll down until you see Microsoft
Edge. Click ‘Add to Edge’ and the Windows Store will open. Quit
Microsoft Edge, then click the button marked Free to install.

BLOCK ALL
This stops cookies
from tracking you
and is enabled by
default. Do this and
Ghostery will update
its tracker database.

Explore
Stop websites tracking you

PURPLE BOX
Open Ghostery’s
box at any time by
clicking on the '…’
button in Microsoft
Edge and then on
Ghostery App.

Jargon buster!
Browser extension
A piece of software,
such as Ghostery,
that is designed to
extend the function
of your browser. Only
install from trusted
sources such as the
Windows Store.
Cookies
A small piece of data
used by third parties
to identify you.
Cookies are usually
downloaded and
stored by your
browser. Ghostery
prevents this.
Blocking cookies
Some web browsers
include an option to
block cookies
altogether. Some
sites may not load if
you do this, which is
why it’s better for
you to use Ghostery.

RESTRICT SITE
Blocks all trackers
and is enabled by
default. Only use this
if you’ve previously
trusted the site or
paused blocking.

PAUSE GHOSTERY
Click to temporarily
disable blocking of
tracking cookies
across all websites.
Use only if pages are
loading incorrectly.

MAP THESE
TRACKERS
Requires a Ghostery
account. Click to see
exactly who is trying
to track you and
where they are.

TRUST SITE
Click this button to
allow all trackers on
a particular website.
You should only do
this if a site isn’t
loading correctly.

Ghostery download
3 Begin
At this stage Ghostery may ask you to confirm your date of

to Ghostery
4 Welcome
A notification will appear at the top right explaining that

birth and region. Enter this and click Next. The Windows Store will
say ‘Acquiring Licence’, then ‘Downloading’. The Ghostery
extension is small (0.1MB) so this won’t take long. Finally the Store
will tell you that the product has been installed. The button below
the Ghostery logo will now read ‘Launch’. Click this to open Edge.

Ghostery has been installed. You still need to activate it, so click
‘Turn it on’. You’ll now see a ‘Welcome to Ghostery’ splash screen.
At this stage Ghostery will ask you if you wish to share data about
trackers you encounter while browsing. This is entirely optional
but helpful to detect new threats. Choose Yes or No as you see fit.
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an account
5 Create
Ghostery now displays the Create an Account window. You
don’t have to do this but it allows access to extra features, such as
syncing settings across your devices. You’re also allowed one free
trackermap scan per month to help you locate companies that are
tracking you across the internet. If you don’t want to create an
account right now then click ‘Maybe later, let’s get started’.

what to block
7 Choose
Click on the word ‘General’ next to Blocking Options. Most
options can be left ticked. However you may wish to scroll down
to the Purple Box section. By default Ghostery displays a small box
for a short time when you visit a new site listing all the trackers
that have been blocked. You can switch this off or change the
duration (default is 15 seconds) and position of the box here.

your tracker options
6 Choose
Ghostery will next launch the main Tracker Options window.
Scroll down to see various types of trackers which Ghostery can
detect such as Advertising and Social Media. The easiest option
for now is just to click on Block All to ban all trackers. If this causes
issues later, you can return to this screen by clicking on the More
option in the Ghostery Box and then Advanced Blocking.

Trusted Sites
8 Configure
Although you can visit sites individually and click Ghostery’s
Trust Site button, it’s easier to set this up here. Click the Trusted
Sites option at the top of the page. Once it loads enter the name
of the website in the white bar at the top, then click on the green
‘+’ button. Repeat for any websites you fully trust. Hover over a
website and click the ‘X’ to remove it from this list at any time.

pilot Ghostery
9 Test
Once Ghostery has been set up. Click the address bar at the

an ad blocker
10 Install
Although Ghostery can prevent websites from tracking you,

top and visit a social media or news site to check that everything
is in order. If the purple box doesn’t appear click the ellipsis (…)
button at the top right of the Edge window then Ghostery App to
view any blocked trackers. You can enable individual trackers here
or choose to trust the entire site, allowing all cookies.

it can’t stop all pop-up ads or those annoying ads that load when
you’re trying to watch YouTube. Fortunately Adblock Plus is also
available for Microsoft Edge. Open the Windows Store and search
for its name, then install. This reduces the chance you’ll
accidentally click on a link and download malware. Q
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Get more from
File Explorer
<ʝʦɠʔʦLȫɏ5ɼɊ0HDɍ*ȾȭʑɚVʋ\ɡ

“Discover new ways to view, edit
and arrange Àles and folders on
your PC with these tips and tricks”

At a glance
Skill level…

Anyone can do it
Straightforward
Tricky in parts

Suitable for…
Windows 10
Windows 8.1
Windows 7

W

hatever you do in Windows
10, chances are you’re going
to use the File Explorer at
some point. It’s the graphical user
interface (GUI) that enables you to
ﬁnd, edit, copy, delete and organise
your ﬁles. And in Windows 10, it
carries a myriad of useful features
that enable you to do more with ease:
from taking a sneak peek at the
contents of ﬁles without actually
opening them; to changing the
default ﬁle and folder views.
The quickest way to access File
Explorer is to click the dedicated
shortcut in the taskbar. You can also
open it using [Win] + [E]; by clicking
its option in the Start menu (just
above Settings); or by asking
Windows 10’s virtual personal
assistant, Cortana. In this tutorial
we’re going to explain the tips, tricks
and customisation secrets that can
help you master File Explorer. So, let’s
crack on, shall we?

Step-by-step Get started with File Explorer

QUICK ACCESS
Click any item here
to quickly jump to
the relevant folder.
Some items, such as
the Documents and
Pictures folders, are
here by default, but
you can easily add
your own shortcuts.

the Ribbon
1 Reveal
You may not be able to see the Ribbon when you first open

the view
2 Change
Under View > Layout you’ll see a range of options, including

a File Explorer window. If that’s the case, either click on the down
arrow on the right side of the window, or press [Ctrl] + [F1]. You
should now see four tabs: File, Home, Share and View. Select View
to reveal the different ways you can change how a File Explorer
windows contents are displayed.
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MAIN WINDOW
The ﬁles and folders
in the currently
selected location.
Select Ribbon >
View to change the
way these items are
displayed: in a list, as
small icons, etc.

Large Icons, Small Icons, etc. Mouse over each one to see how it
changes the way contents are displayed. To make each change
more permanent, click the option you want to use. Now if you
close the window, then reopen it again, you will see the change
you have made has stuck. You can change the view at any time.

RIBBON
The four tabs – File,
Home, Share and
View – contained in
this toolbar let you
to perform various
actions on ﬁles, on
folders and on File
Explorer itself.

Explore
Get more from File Explorer
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Jargon buster!
Quick Access
Previously known as
Favourites, Quick
Access contains
items you’re likely to
use most often.
Certain items are
included by default,
but you can add
whatever you wish.
Ribbon
This toolbar adapts
to what you’re doing,
so the right actions
are always available
at the right time.
Shortcuts
Combinations of
keyboard characters
you can use to carry
out certain actions.
Often listed besides
menu commands.

SEARCH
Quickly ﬁnd any
item by typing what
you’re looking for
into the Search box.
You can also search
your computer using
Cortana, of course.

PREVIEW PANE
Enable this option to
get a sneak peek at
a ﬁle without having
to open the relevant
application. Works
best with pictures
and video.

CHANGE VIEW
You can switch
between content list
and large thumbnail
views in File Explorer
by selecting the
relevant button: left
for content list; right
for large thumbnail.

a sneak peek
3 Take
Head to View > Panes and click Preview Pane. You’ll now see
a preview of the currently selected file or files (useful for pictures
and video) without having to open it in a compatible application.
You can resize the Preview Pane for a closer look by clicking and
dragging the grey border to the left (the cursor will change to a
double-arrow). Double click to open the file in the relevant app.

more details
4 See
If you want to know more about a file, go to View > Panes
and select the Details Pane. This reveals further info, including
EXIF data in any photos. As you mouse over some of the details
you’ll see a grey outline appear around them. This means you can
edit them. Double-click to change the current selection. You can
add titles, tags, star ratings and other info right in File Explorer.
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your stuff
5 Sort
By default, File Explorer displays items in alphabetical order.

a group
6 Form
You can sort also files and folders into groups. Again this is

To change this go to View > Current View and click Sort By to
reveal a drop-down menu. You can view items by name, date, tags
or any one of seven other options, as well as in ascending or
descending order – handy if you’re trying to find the latest version
or are trying to save space by weeding out the largest ones.

handy for identifying certain kinds of file, such as any images you
have tagged. To do that, go to View > Current View > ‘Group by’
then choose from your options. You’ll see the window layout
change to reflect your selection. If you select by File Type, for
example, you’ll see files are listed under File Type headings.

your columns
7 Customise
Another way to get at-a-glance info is to customise the

files and folders
8 Share
File Explorer makes sharing easy. Go to Ribbon > Share >

columns File Explorer shows. In Layout > Details and Current View
> ‘Group views’ you’ll see default columns, but you can change
these. Go to Current View > Add Columns and select Choose
Columns. A Choose Details window appears. You can now choose
the columns you want to see. Click OK once done.

Send > Share to upload files to apps and services such as Mail and
Facebook. Select Send > Zip to compress them, or use the options
in the next column to print, fax or burn them to disc. To share
items on a local or public network, select Share With > ‘Specific
people…’, then choose your options from the window that opens.

File Explorer options
9 Other
While you can select multiple files and folders by clicking

Quick Access
10 Customise
If you regularly access certain items, Quick Access can help.

and dragging or [Ctrl] + clicking, there is another option. Go to
View > ‘Show/hide’ and select and check the ‘Item check boxes’
option. Every item will now have its own check box, making it
easy to select them quickly. This section also lets you to show or
hide file extensions and show or hide individual files and folders.

It enables you to pin them to its menu, which sits in File Explorer’s
sidebar. Select the Quick Access menu itself and you will see your
favourites on top with recent files below. To add an item to Quick
Access, select it, then go to Home > ‘Pin to Quick Access’. To
remove it, right-click it and select ‘Unpin from Quick Access’. Q
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SECURITY
CAMERAS
A security camera is many people’s first
smart home device, and the latest
models have sophisticated technology
inside them. Here we look at what you
should consider before buying one…

T

here’s no doubt that
we see more
information about
security cameras
than any other type
of smart home
product. In fact, browsing the
website of one high street
electronics store recently revealed
no less than 68 different cameras,
with the majority falling into the
£100 to £200 price range.
Having such a wide range of
an make it
products, however, can
ne. Whichever
difÀcult to choose one
c e e
number
you pick there are a n
of key features and
e
technologies that are
worth thinking
about when you
buy your Àrst
security camera.

Look sharp

Top of the list for anyy
camera, of course, is
e all
image quality. We’ve
seen news reports
otage
on TV with video foo
g
end up
that’s so blurry you e
wondering why they
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bothered spending any money on a
CCTV system in the Àrst place. Most
manufacturers provide affordable,
entry-level security cameras with
720p resolution (1,280x720 pixels)
for around £80, and we’d certainly
recommend that as the minimum
requirement for a security camera.
Ideally, though, it’s worth
stepping up to a camera that
delivers Full HD video (1080p, or
1,920x1,080 pixels). Netgear’s Arlo
Q (£170, http://bit.ly/2kX20vE),
for example, is one of the most
affordable cameras of this qualityy;
most
designed
for indoo
os cameras
cam
g
or
settle
use seem
see to
o se
e aat aaround
ou d
£160, though
£
g we’ve seen thiis
one
o
e for
o as low
o as £120.
0
Full
cameras
Fu HD ca
e as will
provide much better image
qualityy if yyou ever need to
use footage
g as evidence
e in
the
unfortunate
event
eu
o u aee
e of
a crime. A good
camera
g
in this price range
g
should
also p
provide a
s
night-vision
mode ffor
n
g
low light
g conditionss.
The Àrst generatio
g
on
of smart securityy
cameras
ca e as was
as

Feature
Home security

If This,Then That
Many home security cameras support IFTTT (If This, Then
That), a system which enables devices from different
manufacturers to work together. Using IFTTT requires a
degree of programming skill, but IFTTT’s website (https://
ifttt.com) provides prebuilt mini-apps, or applets, that will
work with many devices.
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How many
cameras can I
use at a time?

The phone apps for
most security cameras
enable you to monitor
a number of cameras in
different rooms around
your home. However,
some may require
additional hardware
in order to control
multiple cameras, such
as the Base Station sold
with Netgear’s Arlo
cameras, or D-Link’s
Connected Home Hub.

What about
indoor or
outdoor use?

Most security cameras
are designed to be
used indoors, and
aren’t particularly
sturdy. If you want a
camera for outdoor use
then you should look
out for a two-digit IP
rating. The Àrst digit
refers to resistance to
dust and other
damaging particles,
while the second digit
indicates waterresistance. Netgear’s
Arlo Pro is rated at IP65.
See http://bit.ly/
2kQkNWX for details.

pretty straightforward, relying on simple motion
detection to keep an eye on things while you were
away from home. If the camera detected any
movement while you were out, it would
automatically start to record video footage and
send an alert to your phone. However, the latest
models are starting to use sophisticated artiÀcial
intelligence techniques that provide more
advanced features.
The Welcome camera (£199, http://bit.ly/
2kAikkQ) from Netatmo was one of the Àrst to use
face recognition technology to tell the difference
between a burglar and your kids arriving home
from school. Netatmo’s newer Presence camera
(http://bit.ly/2l1l6A8) goes even further; it’s a bit

HomeKit. These will enable you to control the
cameras by giving verbal commands to Siri on your
iPad or iPhone, and use iOS 10’s Home app to link
the cameras to other devices that also work with
HomeKit, such as motion sensors and lighting. The
Nokia Home also works with Android devices.

Sound and vision

ArtiÀcial intelligence is advancing in other areas,
too. Most security cameras include a microphone
so they can record both sound and video, but
Swann’s SoundView camera (£150, http://bit.
ly/2kAxfeP) can listen for speciÀc types of sound,
such as breaking glass, that might warn you of a
possible crime. However, the most advanced sound

“Intelligence in cameras is improving so that
they can, for example, alert you only to
human movement, not pets”
pricey at £250 due to being weatherproof for
outdoor use, and includes a powerful Áoodlight,
too. It’s designed to monitor activity outside your
home or ofÀce, so Netatmo developed new
software that it claims can differentiate between
people, pets and passing cars. Netgear‘s outdoor,
weatherproof Arlo Pro (£275, http://bit.ly/
2ku1Yb2) claims to be able to recognise trees
swaying in the breeze so that it doesn’t keep
sending you false alarms on a windy day.
Logitech’s indoor Circle 2 camera (£169-£199,
http://bit.ly/2kcZ613) is a seriously capable
camera and is to gain a ‘people recognition’
feature, so that it only reacts to human intruders
rather than pets wandering into view. And there’s
Nokia’s Home (£170, http://nokia.ly/2uZO1KR),
and an unnamed camera
from D-Link, which will be
the Àrst security cameras
to support Apple’s

technology we’ve seen so far comes from Cocoon
(£159, https://cocoon.life). It uses Subsound
technology that can pick up faint sounds and
vibrations from all around your home, not just in
the one room where the camera is located. It can
detect sounds such as creaking Áoorboards, and
claims to be smart enough to tell the difference
between your kids charging up and down the stairs
and a burglar tiptoeing around at night.
There are some other weird and wonderful
variations on the security camera theme. Sengled’s
Snap (£180, http://bit.ly/2kAo0vb) sneakily hides
a 1080p camera inside a power-efÀcient LED smart
light bulb, enabling you to monitor areas such as
hallways or stairs without revealing the presence of
a security camera. We also like the Canary camera
(£160, https://canary.is/uk), which combines a
1080p Full HD camera with a honkingly loud siren,
and even a sensor to check humidity and air
quality in your home.

Feature
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Facts…
$47.5bn

The estimated value
of the global home
security market in
2020. (RnR Market
Research)

61%

The amount of smart
home spending in the
US that’s attributable
to security cameras.
(NPD Connected
Intelligence)

701,000

The number of
burglaries in the UK in
the year to March
2016. (Office for
National Statistics)
While security cameras are often the Àrst smart
home device that most of us buy, many cameras
are also designed to be used in conjunction with
other security devices, such as motion sensors
and contact sensors that can be attached to
doors and windows around your home.
Examples includes the Hive Motion, and Hive
Door or Window Sensors (www.hivehome.com),

and the Apple HomeKit-compatible Elgato Eve
Door & Window, and Eve Motion sensors (www.
elgato.com/en/eve). Both brands’ products will
alert you using apps on your smartphone in the
event that one of their sensors is triggered.
The Philips Hue Motion Sensor (£35, www2.
meethue.com) takes a different tack: it switches
on nearby Hue lights when it detects movement.

4.4%

Baby monitors are on
the rise too, forecast
at 4.4% global growth
every year until 2020.
(Transparency Market
Research)
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COCOON
£159

LOGITECH CIRCLE 2
£169-£199

NETATMO PRESENCE
£250

NETGEAR ARLO Q
£170

NOKIA HOME
£170

As well as its 1080p
camera and nightvision mode, Cocoon
uses Subsound tech
to detect sound and
vibrations throughout
your home. As well as
sending alerts to your
phone, it has a seriously
loud 90dB siren.

There are more
advanced cameras
around, but we like
Circle’s ease of use and
semi-portable design.
It’ll spend most of its
time in its mainspowered dock, but its
rechargeable battery
lasts for up to 12 hours.

Presence is one of the
best outdoor cameras
you can get right now. It
provides 1080p Full HD
resolution with night
vision, and has a
Áoodlight to scare away
intruders. You can save
video to an SD card or a
Dropbox account.

This 1080p Full HD
camera provides
two-way audio and
night vision. But the
best thing about it is
that you get to store
the last seven days of
video footage online
for free, with no need
to pay a monthly sub.

From the company
formerly known as
Withings, this is a 1080p
Full HD camera that
works with iOS and
Android devices. It’s also
one of the Àrst security
cameras to offers full
integration with Apple’s
HomeKit technology.

cocoon.life

logitech.com/en-gb

netatmo.com

arlo.com/uk
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Explained

1

HERE, THERE AND
EVERYWHERE

NIGHT VISION

Many security cameras
claim to have a
night-vision mode that
enables them to work
in low light conditions.
However, the better
cameras will also
include an infrared (IR)
emitter that enhances
visibility at night.

Netgear’s Arlo cameras
cover all bases; there
are indoor and outdoor
models, with Wi-Fi or
Ethernet, and battery or
mains-powered. Netgear’s
even planning a roaming
model with a SIM card for
mobile broadband.

1

2

2

LOCAL STORAGE

“The latest models use
sophisticated artificial
intelligence techniques
that provide even more
advanced features”
Quick tip!

Somewhat oddly,
Netatmo’s Welcome
camera includes an
8GB microSD card,
but doesn’t provide
an online storage
option. You can link
it to a Dropbox
account to store your
security footage
online, though.

If you don’t want to pay for
online storage, the Arlo Pro
has a USB port for
connecting a local drive.
Alternatively, Netatmo’s
Welcome and Presence
cameras include an 8GB
microSD card for
storing video.

HOW TO TELL VISITORS AND STRANGERS APART

1 Home and away

Like most security cameras, Netatmo’s
Welcome can track your location through its app
on your phone. You can link it to other family
members’ phones too, so it knows when your
home is empty and to keep watch.

2 Face to face

Netatmo’s Welcome was one of the Àrst
security cameras to use face recognition. As soon
as you turn it on, it starts to note each new face
it spots. Then you just hold a Ànger on a face in
order to identify that person.

Feature
Home security
WHAT ELSE SHOULD I CONSIDER?

ONLINE STORAGE COSTS
You can view live video for free, but other features may cost you

W

hen your security
camera detects an
intruder, it usually sends
an alert to your phone
and then streams the
video so you can see
what’s going on. However, you may need
to store recordings for longer, perhaps as
evidence of a crime.

Unusually, Netatmo’s Welcome and
Presence cameras include a microSD
card to store video directly on the
camera itself. In contrast, most
manufacturers opt to use online
storage instead, and this is where you
need to watch out for hidden costs.
Netgear’s Arlo cameras enable you
to store video footage online for

seven days for free, which should be
enough for most people. Beyond that
period, it charges £6.49 per month
to store your recordings for 30 days.
Logitech’s Circle 2 stores video for 24
hours for free, before charging £2.99
per month for 14 days of storage.
Swann’s SoundView camera and the
Sengled Snap, however, only provide
you with live streaming – they
provide no free online storage at all.
Check the small print before buying,
as some security cameras require a
monthly subscription fee in order to
store your videos online.

Power over
Ethernet

Most security cameras
run off batteries or
mains power, but some
can use PoE, or Power
over Ethernet, which
enables the camera to
get both power and
internet access from a
single cable. This can be
really useful if you want
to install several cameras
around your home
or ofÀce.

3 The spying game

You don’t need to worry about family
members, but if there are people who only visit
occasionally, you can tell the camera how to
react: to record one video on arrival, or to keep
an eye on them the whole time.

4 Stranger danger

If the camera spots a face it doesn’t
recognise, such as this delivery driver, it will
automatically record video and send an alert to
your phone. It will also take a pic so you can add
that person to the app if you want.

KEEP
WINDOWS7

ALIVE
Still using Windows 7? Here’s how to
make sure it continues to run perfectly

D

espite its age,
Windows 7 is still
the most widelyused version of
Windows used
today, and while
Microsoft has released a number of
successors – including the popular
Windows 10 – many people are
sticking with what they know.
Sticking with an older operating
system because you’re comfortable
using it is understandable, however
as Windows 7 becomes older, there
are certain things you need to do to
ensure that it is running as well as it
could be. This doesn’t just mean
updating Windows 7 to take
advantage of the technological
advancements that have been made
in the seven years since it was
launched – it also means making
sure it remains safe and secure
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against new security threats from
the internet.
In this guide we will show you
everything you need to do if you
wish to keep using Windows 7, while
making sure that the operating
system performs well.
After seven years of use, you may
also Ànd that Windows 7 is
beginning to feel a little sluggish –
we’ll also show you what you need
to do to put a spring back in
Windows 7’s step, and to help you
continue to enjoy Windows 7 for
years to come.
If you end up feeling like it’s time
to move on from Windows 7, then
check out the guide on how you can
still upgrade to Windows 10 for free
at http://www.techradar.com/
how-to/software/operatingsystems/how-to-upgrade-towindows-10-for-free-1325764.

Feature
Keep Windows 7 alive
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How to keep Windows 7 running well

1

Do some spring cleaning

3

Clean up your hard drive

5

Defragment your hard drive

It is highly likely that if you’re using Windows 7, you’re
running it on an older machine that has seen a fair few years of
active duty. In this time you’ve probably accumulated hundreds, if
not thousands of files, folders and programs, and all this clutter
can slow down Windows 7. The first thing you should do, then, is
clean up your hard drives.

Next, you’ll want to clean up your hard drive of any useless
clutter you’ve accumulated. Double-click on the Computer icon
on your desktop. This will display all your hard drives, along with
any USB drives and CD/DVD drives. Right-click on your hard drive,
then select Properties. A window will open – click Disk Cleanup,
select the files you want to remove, then click OK.

This is a bit of a blast from the past. With modern Windows,
or solid-state drives (SSDs), you don’t need to worry about file
fragmentation – where files are scattered in parts across the drive.
With Windows 7 and traditional hard drives, defragmenting it
regularly can help keep it running speedily. From the same tools
tab in Step 4, click on the ‘Defragment now’ button.
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2

Uninstall programs

4

Give your hard drives a health check

6

Clean out Startup programs

Your first step to cleaning up Windows 7 is to uninstall any
applications or programs that you don’t use anymore. If you’ve
been using Windows 7 for a long time, this list could be very long!
To do that, open the Start menu and select Control Panel. From
there, select ‘Uninstall a program’ and choose which programs
you want to remove from Windows 7.

If you’ve been using your PC for a while, its hard drive may
need checking to ensure it’s running ok. First, right-click your hard
drive from the Computer window, go back to Properties, then
click the Tools tab. Under ‘Error-checking’ click ‘Check now’ and let
Windows check your disk. Select ‘Automatically fix file system
errors’ to fix any problems. You may need to restart your PC.

You may have installed programs that start up when
Windows 7 loads. If a number of programs do this at the same
time, this can slow your PC down and cause Windows 7 to take a
long time to boot. To stop programs loading, either uninstall them
or press [Win] + [R] and type ‘msconfig’. Click the Startup tab, then
deselect any programs you want to stop loading at boot.

Feature
Keep Windows 7 alive

7

Reinstall Windows 7

9

Stop using Internet Explorer

If Windows 7 is running very slowly, reinstalling can help it
perform better. Before you begin, make sure you have your
Windows 7 installation CD and key. Also, make sure you save any
important files and folders before you begin. If your hard drive
failed a health check in Step 4, install Windows 7 on a new drive.
Installing it on an SSD will give further performance increases.

While Internet Explorer 11 is still getting security updates
from Microsoft, the company has turned its attention to Edge,
which isn’t available for Windows 7. Instead, download Chrome
(http://bit.ly/1LOGdwL) or Firefox (https://mzl.la/2vap2Vc), which
bring modern features and security updates to Windows 7. It’s
easy to import your bookmarks from Internet Explorer as well.

8

Update Windows 7

One of the most important things you can do is make sure
Windows 7 is up to date. Microsoft will continue to provide
security updates and bug fixes for Windows 7 until 2020, and you
must have Service Pack 1 installed to receive them. To check,
open Start and type in ‘Windows Update’. Select the top search
result, and if updates have been found, click ‘Install updates’.

10

Use anti-virus – and keep it updated

Using an older – yet still very popular – operating system
like Windows 7 can make you a target, so make sure you have a
good anti-virus program and you keep it updated. While Windows
10 comes with Windows Defender built-in, Windows 7 doesn’t, so
try Microsoft Security Essentials (http://bit.ly/2w364wb) or free
alternatives such as AVG Free (http://bit.ly/2w3667h). Q

Talk to your PC
The Cortana voice assistant is a big
feature of Windows 10, but you can
get a similar experience in Windows 7
by installing Google Chrome, then
tapping the microphone icon on the
Google homepage.

WINDOWS HELP HARDWARE FIXES SOFTWARE SOLUTIONS INTERNET TIPS
Backing up

FIX BACKUP AND
RESTORE ERROR
Do you have a
PC problem?
Get in touch…
Email complete details
of your problem to the
support team and we’ll
do our best to help
windowsmagazine@
futurenet.com

Q I’m running a new PC and

have switched from Windows
Live Mail to Outlook. Recently, after
using the old Windows 7 Backup
tool to back up to my external hard
drive I received the following error:
“Check your backup results. The
backup completed but some ﬁles
were skipped”. I investigated
further to discover two errors

(0x80070002) referring to C:\Users\
defaultuser0\Contacts and C:\Users\
defaultuser0\Searches respectively
(neither ﬁle could be found). The
Windows Troubleshooter was no
help – can you resolve this please?
Allan Bolton
Cat’s solution
This is a well-known
error, and the good
news is that you can
safely ignore it if you wish – the

backup still works. However, you
may want to remove the annoying
message that will continue to
appear. Open Backup and Restore
- press [Win] + [R], type ‘sdclt.exe’
and click OK – and then click
‘Change settings’. Click Next, then
select ‘Let me choose’ if necessary
and click Next again.
Expand ‘Data Files’ followed by
‘Your username’s Libraries’ >
Additional Locations and clear the
tick boxes next to the AppData
folder, Contacts and Searches. Now
expand Computer > C: > Users >
‘Your username’ and tick the
AppData, Contacts and Searches
folders if they exist. Click ‘Next’
followed by ‘Save settings and exit’,
then perform a fresh backup to
verify the issue has been resolved.
Windows

RESET FORGOTTEN PIN
Q I have set up my Windows 10

PC, so I only need a password
to sign in. I have lost my PIN for my
Microsoft account. Do I still need a
PIN and how do I get it back?
Graham Jones

FIX ERROR Resolve
selected backup
errors by changing
what’s backed up.
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Support
Technical help

FIND THE SOLUTION! Data Crow video tutorials
Need help using the Data Crow media cataloguing app? Check
out the videos on its YouTube channel at http://bit.ly/data-crow

Quickfire questions
Why has my printer suddenly
start displaying its properties
in a foreign language?
Terri Smith-Jones
Go to Start > Settings >
Devices > ‘Printers & scanners’,
click on the printer and choose
Manage. Work through your
options looking for a language
option. If this doesn’t work,
uninstall the printer driver and
then reinstall it.
Why can’t I get my Gioteck
VX-2 wireless game controller
to work without using a cable?
Peter Lewick
If it’s the Playstation 3/PC
model, then the wireless
connection will only work with
the PS3, sadly.

MONITOR BOOT Discover what slows your PC’s start times with BootRacer.

“A lot of people have complained on user forums about the
Creators Update resulting in noticeably slower boot times”
Rob’s solution
Assuming you’re
referring to the PIN you
can assign to Windows
10 to speed up logins, then they’re
easy to remove (or replace) because
they’re device-speciﬁc and can be
bypassed using your account
password. Once logged into your
Windows user account, click Start >
Settings > Accounts > Sign-in
Options. You’ll see options to
change, remove or reset your PIN.
Change won’t work because you
have to know the PIN to change it,
but you can reset your PIN by
clicking ‘I forgot my PIN’, or remove
it – enter your account password
when prompted. Once done, you
can then set up a new PIN.

The pre-boot time should be
around 3-5 seconds on a PC with
Fast Boot enabled – if not, check
your UEFI settings to see if the
option’s available (it should be on
most modern PCs).
If the bottleneck appears to be
linked to the Windows Boot portion
of startup, it may be caused by disk
errors. Right-click the Start button
and choose Command Prompt
(admin), then type ‘chkdsk c: /f /r /x’
and hit [Enter], rebooting your PC
to run a check. Be patient – it may
take some time to complete and
appear to be stuck. If this doesn’t

Jargon buster!
Aero Peek
A feature that enables users to
temporarily peek at the
desktop behind any open
windows. Roll the mouse to
the bottom-right corner of the
desktop to activate it.

WORD
REPLACEMENT
AbiWord is a solid
– and free – word
processing app.

AppData
A hidden folder that contains
user-speciﬁc conﬁguration
data stored by Windows and
third-party programs.

Windows

IDENTIFY BOOT
BOTTLENECKS
Q Since installing the Creators

Update, my PC is taking much
longer to boot. Any pointers?
Julia Rendbury
Ian’s solution
A lot of people have
complained on user
forums about the
Creators Update resulting in
noticeably slower boot times. The
key thing is to pinpoint where the
bottleneck occurs. To determine
where it is, download and install
BootRacer (www.greatis.com/
bootracer/), which will time your
boot and split it into four stages.
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Quickfire questions
I wish to install the Creators
Update on my HP laptop. Is it
best to leave the PC plugged in
while it happens? I don’t want
to overcharge the battery.
Graham James
The battery is designed not to
overcharge – when it’s at 100
per cent, the charger acts as a
straightforward power adapter,
so leave the laptop plugged in
while updating.
How can I stop my open
windows disappearing
whenever the mouse cursor is
placed in the bottom righthand corner of the desktop?
Natalie Sawicka
Roll your mouse to the bottom
right corner of the Taskbar and
right-click to reveal a pop-up
menu – untick ‘Peek at
desktop’ to disable the feature.
I want to write some free-form
biographies of ancestors.
Which family history tool can
help with this?
Allie Cookson
Family Tree Maker’s Smart
Stories is a great tool – see
www.mackiev.com to order
– or try My Family Tree, which
is available free from www.
chronoplexsoftware.com.
Select your ancestor and click
‘Photos and story’ to access a
more basic story tool.

improve matters, go to Start >
Settings > System > ‘Power & sleep’
> ‘Additional power settings’ and
verify ‘Turn on fast start-up’ is
enabled under ‘Choose what the
power buttons do’ (if it’s not, click
‘Change settings that are currently
unavailable’ to tick the box).
Finally, a lengthy Desktop time
refers to start-up programs (click
Enable Control for more detailed
analysis to identify the culprits). You
can then disable these within
BootRacer or via the Start-up tab
under Task Manager.
Microsoft Oﬃce

I’M HAVING TROUBLE
RUNNING WORD 97
Q I am trying to run Oﬃce 97
under Windows 7. During
installation, I was informed
CTL3D32.dll was missing – I
subsequently installed it, but every
time I launch Word it asks me if I
want to reverted to the saved ﬁle
name. The program closes
regardless of whether I answer yes
or no. Excel and other Oﬃce apps
work ﬁne. Please help!
Alan Puﬀett

DISABLE
SETTINGS
Use this
workaround to
avoid sleeprelated crashes.

Rob’s solution
Oﬃce 97 isn’t technically
compatible with
Windows 7, even though
you have managed to get the other
apps working. We’d suggest that
you upgrade to a compatible
version of Oﬃce (Oﬃce 2003 or
later) or switch to an alternative
oﬃce suite. Given the other apps
appearing to be working correctly
you could look to simply replace
Word with AbiWord (www.
abisource.com), or you could go the
whole hog and install LibreOﬃce
(www.libreoﬃce.org). You can run
both programs alongside each
other as well as Oﬃce 97 while you
decide which one is best for you.

Hardware

PC WON’T BOOT
SUCCESSFULLY
Q After successfully installing the

Creators Update followed by
my NVIDIA graphics drivers,
Windows 10 will no longer boot –
after 10 minutes of going nowhere
it puts me into Repair mode and
then ﬁnally allows me to restart in
Safe mode. Can you provide me
with some pointers for what I
should try and do next?
Tony Prodger

Matt’s solution
We ﬁrst thought the
problem might be the
driver update, so
pointed Tony to a tool he could use
in Safe mode (Display Driver
Uninstall Tool, available at www.
wagnardsoft.com). However, the
situation quickly deteriorated – and
switching to another graphics card
known to work with Windows 10
had no eﬀect. Eventually, his power
supply failed after a fan jammed,
and after replacing this, Tony was
forced to reinstall Windows 10 from
scratch. Everything proceeded
normally except for a power-saving
issue whereby the PC would freeze
after 10 minutes, when it tried to

FIX CDTAGGING
PROBLEMS
Q I’ve been using Mp3tag as

recommended in issue 136’s
cover feature. I have some CDs with
generic names that the Discogs
search can’t ﬁnd. Can you help?
Roy Palmer
Nick P’s solution
If you upgrade to the
latest version of Mp3tag
– version 2.83 or later
– you’ll ﬁnd that a new option has
been added to the Tag Sources list:
Discogs Release ID. Here’s how to
use the app to ﬁnd the correct
match for your CDs.
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album on Discogs
1 Locate
Point your web browser to www.
discogs.com and search for the artist in
question. Click their artist entry and then use
the Releases sidebar on the left to locate the
album, single or compilation you’re after.
Click its title to access its page.
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release ID
2 Discover
Scroll through the list of releases
looking for an exact match (typically UK or
Europe) using the catalogue number to help
identify it. Click this release, verify it’s the
correct one and then copy its ID from your
browser’s Address bar.

Support
Technical help
enter low-power mode. By going to
Start > Settings > System > ‘Power
& sleep’ you can set the Sleep
setting to Disable to work around
the problem while carrying out
other troubleshooting options.

Windows 10 from Windows 7 or 8
and haven’t performed a clean
install since, it may be time to bite
the bullet and clear everything out
by following this month’s cover
feature, starting on page 14.

Windows

Email

CREATORS UPDATE IS
FULL OF GLITCHES

WINDOWS LIVE MAIL
REPLACEMENT

Q There seems little point in

installing this update if it
comes with a whole load of
problems. Edge has stopped
working, System Protection was
turned oﬀ and all Restore points
deleted, and my boot time has
more than doubled. Will Microsoft
be issuing a ﬁx for all these
problems? All my Windows 10
computers are similarly aﬀected.
I’ve tried the ﬁx at Microsoft Help
but no change – do have you any
advice or solutions?
David Reece

Q Had trouble with my PC and

went back to square one by
reloading Windows 10. Then
Microsoft took an hour to update it
and I’ve been left with this awful
Mail app instead of Windows Live
Mail. How can I get Outlook or
Windows Live Mail again? At 85 I’m
getting too old for this pretty stuﬀ
– wish I’d stayed with Windows 7!
Harold Tokins

Cat’s solution
Unfortunately, Microsoft
has retired Windows
Live Mail completely.
We suspect that by Outlook that
you mean Outlook Express, which
is also long gone – while some
people have managed to get both
programs working in Windows 10
brieﬂy, major updates led to them
breaking again.
The best way to future-proof
yourself is by switching to Mozilla’s
highly acclaimed Thunderbird
email program, which is available at
www.getthunderbird.com – there’s
a bit of a learning curve at ﬁrst,
sadly, but its user interface is
relatively straightforward and it’ll
continue to work in future versions
of Windows too.

Do you have
a PC problem?
Get in touch…
Email full details of
your problem to the
support team and we’ll
do our best to help:
windowsmagazine@
futurenet.com
Or you can write to the
support team at:
Support Squad,
Windows Help &
Advice magazine,
Future Publishing Ltd,
Quay House,
The Ambury,
Bath BA1 1UA

Nick P’s solution
We sympathise with
your plight, David. It
seems Microsoft
switches oﬀ System Restore after
every major update – I don’t know
if that’s to stop people trying to roll
back through System Restore rather
than via Settings > ‘Update &
security’ > Recovery, but the fact
it’s not advertised is poor form.
The Edge browser problem has
aﬀected some machines, but not all
(it works perfectly on all our test
PCs, for example). We tried to ﬁx
this on another reader’s PC and
were forced in the end to suggest a
repair or even a clean install.
This option may seem like
overkill, but if you upgraded to

“The best way to future-proof yourself is to switch to Mozilla’s
highly acclaimed Thunderbird email program”
Jargon buster!
Discogs
An online music database,
which contains information
and artwork for millions of
artists, albums, singles and
compilations that can be
added to other programs.

release ID
3 Input
Open Mp3tag and choose File > Change
Directory… to select the folder of the album
that you wish to tag. Now select all the tracks
and open Tag Sources > Discogs Release ID.
Paste in the release ID from the previous step
and then click Next.

and tag
4 Match
Check the information matches (and
make sure the tracks line up correctly) – click
OK to tag your files with the metadata
provided. If no cover is provided, you could
download this separately from Discogs and
manually add it to your files.

Fast Boot
A boot method employed by
modern PCs to speed up
startup by – among other
things – bypassing certain
checks and streamlining
hardware initialisation.
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76 How to master the
Just starting your
Windows journey? Windows 10 desktop
Confused by the
changes Microsoft
has made to the
Creators Update? Maybe you
just want to learn something
new about Windows 10. Well,
this is the section for you!
There’s not enough space to
tell you absolutely everything
you need to know here, but
Windows Help & Advice always
has your back. In our essential
Basics section, we’ll show you
how to: master the desktop and
make it work for you; customise
the Start menu and quickly
access favourite items using
tiles; and how to get the best
from Windows 10’s virtual
personal assistant, Cortana.

78 Change the way
the Start menu works

80 Discover the ways
Cortana can help you

REINSTALL
WINDOWS 10!
FIND OUT HOW
ON PAGE 14

Matt Hanson
Associate Editor
www.facebook.com/windowsmag

Windows 10 tip of the month

Customise the Calendar app

Change the way that Calendar looks
Windows 10’s built-in Calendar is a great
way to organise your day. But you can
make it easier and more attractive to
use with a couple of simple tricks, which
we’re going to show you right here. You
can open the Calendar in three different
ways: by choosing its app icon from the
Start menu; by typing ‘calendar’ in the
Search box; or by saying ‘Hey Cortana,
open Calendar’. You can even ask her to
open it on a specific date.

DATES Click ‘Add calendars’ and choose a country from
the ‘Holiday calendars’ list to add its public holidays.

LOOKS Go to Settings > Personalisation to change the
selected calendars accent colours and background.
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Master the desktop

You’ll spend a lot of time there, so here are
some great ways to make it work for you…

hen not actually using
applications, the Windows
desktop is where you’ll
spend much of your time,
moving ﬁles about, hunting for that
obscure application you installed six
months ago and suddenly need, or
lining up your windows so that they
ﬁll the space perfectly (a time-wasting

W

pastime that’s all but dead now
thanks to window snapping).
In Windows 10, the desktop and the
taskbar get a few new tricks that
make working with ﬁles and folders
even easier, and the new search bar
means pulling up an application you
don’t use often is a breeze. Follow
these tips to a happy start…

desktop/peek
1 Show
The Show Desktop button isn’t marked, and some people

desktops
2 Virtual
If you find your desktop frequently getting overcrowded as

don’t even know it exists. Press this anonymous section at the
extreme right of the taskbar, and all your open windows will
minimise. Hover the mouse pointer over it, and you’ll get a
preview ‘peek’ at the desktop that reverts when you move your
mouse pointer away. It’s very useful when you’ve got a chaotic
number of windows open on your desktop.

you work, why not offload some of the mess onto another one?
Click the Task View button to the right of Cortana’s search box on
the taskbar, and you’ll be taken to a screen that shows your open
apps, and also your desktops. Add a new one, or even more, and
you’ll be able to flick between them with different apps open on
each. It’s a great way to stay organised on your PC.

inactive windows
3 Scroll
An annoyance for anyone who’s come to Windows from

snapping
4 Window
A real godsend for those who used to tease their window

using the Mac, the ability to scroll the window your pointer is
currently over – instead of the one that’s currently active – is new
in Windows 10. So, if you have a browser and a word processor
open, and are reading one while typing in the other, you can now
scroll down in the browser without having to take your focus
away from your text document.
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edges out until they exactly matched the edge of the screen,
snapping in Windows 10 enables you to have two or more
windows open that completely fill their areas of the screen. Pick
up a window and move it to the extreme left or right edge of the
desktop to try it (you’ll see it ‘snap’ to the new half screen format).
You can adjust how much of the screen they take up too.

Welcome to Windows 10
Master the desktop

icons
5 Desktop
The Windows 10 desktop icons have a pixellated look, and
if this offends you it’s easy to change them. Luckily, there are icon
packs available online – including the shinier Windows 8 icons.
Download the icon pack you want to use, then go to Start >
Settings > Personalisation > Themes. Click the ‘Desktop icon
Settings’ and select the icons you want to place on the desktop,
then use the Change Icon option to change their look.

7 Notifications
The notifications panel – or Action Centre – slides in from
the right of the screen, with a button in the system tray, and will
house any messages that apps or Windows components want to
send you. It’s where you’ll find links to details of Windows updates
that have been installed on your machine, and any social media
messages or upcoming calendar events. You can customise it so
it’s as intrusive as you can deal with.

to minimise
6 Shake
This may sound like something left over from a tablet build
of Windows that needs a built-in accelerometer, but picking up a
window with your mouse pointer and shaking it back and forth
will minimise every other window, leaving you with a clear and
uninterrupted view of the one you want to work with. It’s much
faster than clicking several minimise buttons, and it’s a fun little
quirk that’s a good one to remember.

management
8 Window
In addition to window snapping, you can arrange your
windows in some other ways too. Right-click on the taskbar to
reveal three window arrangement schemes: ‘Cascade windows’;
‘Show windows stacked’; and ‘Show windows side by side’. These
are similar to the Window menu’s functions that have been
available all the way back to Windows 3.1, and can make it quick
and easy to find what you’re looking for.
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Customise the Start menu
The Start menu in Windows 10 is more powerful than
ever – here are some easy tips to make it work for you

he Start menu’s return was big news
when Windows 10 launched, and it
has evolved as the operating system
has been updated. It’s become a fast,
and eﬃcient way to access apps and settings –
Windows 8’s full-screen monstrosity is now a
distant memory, thankfully!
However, if you don’t like how the Start menu
looks when you ﬁrst pop it up on your fresh

T

install of Windows 10, it doesn’t have to stay that
way. It’s fully customisable in ways that were
never possible in earlier versions of the
operating system, and can be made to work in
just about any way you want, standing out from
its background for ease of reading, or
automatically blending in with the colour
scheme of whatever theme you have currently
set on your desktop.

1 Colour
Your Start menu’s background can be any colour you like

2 Size
To make space for all the customising you can do to the

– all you have to do is untick a box. Open up Settings, then
Personalisation and finally Colours. Untick the ‘Automatically pick
an accent colour from my background’ option and you’ll be able
to pick a colour from the palette. So your Start menu can be a
contrasting red or yellow rather than a dull blue or grey. Play
around to find a combination that works for you.

Start menu, you can easily resize it to your liking. Just move your
mouse pointer to the top-border or right-border of the Start
Menu, the pointer will change into arrows, and you’ll be able to
increase or decrease height and width, dragging it out to
completely fill the screen if you want to. This is particularly useful
if you have a PC filled with programs that you access regularly.

and tiles
3 Folders
Your Start menu is made up of lists and tiles, and some of

program lists
4 Hide
By default, the Start menu will show you lists of both your

these can be shortcuts to folders such as Documents. Settings >
Personalisation > Start enables you to tinker with this, so if you
never shoot videos you can stop the empty Videos folder from
taking up space on the menu. You can turn the links to the
Settings window, and the one that opens an empty File Explorer
window, on and off too.

most used programs and the most recently opened ones. This can
end up repeating itself, so if you want to get rid of one or the
other of the lists, or both, open up Settings > Personalisation >
Start, from where you’ll be able to toggle the lists on or off. You
can also prevent apps from appearing on the lists so you only get
a view of the things you really need from day to day.
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it to search with
5 Use
Hitting the [Win] key on your keyboard to pop up the Start
menu’s Search box is one of the fastest ways to look for anything
in Windows 10. Just type a few characters and you will get
suggestions for applications and documents stored on your
computer that match your initial query. You can also use the
arrow keys on your keyboard to navigate the Start menu, if you’d
rather not use the mouse.

tiles and shortcuts
7 Pin
If there’s something you need to be able to find quickly, but
which gets lost in the lists of the Start menu, you can pin and
reposition it so it’s always prominently placed. To do that rightclick an item and choose ‘Pin to Start’. It will now appear in tiles.
Now click and drag the tile to where to want to move it to. To
resize the tile, right-click, choose Resize then the tile size you
want. You can pin shortcuts to the Taskbar for easy access too.

tiles
6 Live
Live tiles are tiles that are constantly updated with data,
usually gleaned over the internet to make them up-to-date.
There’s one for the Mail app that shows your most recent
messages, one for the Weather app that uses your PC’s location to
tell you what’s going on outside the window, and so on. If you
find them distracting, you can turn them off by right-clicking
them and choosing the appropriate option.

back the Start screen!
8 Bring
It may have been almost universally mocked and reviled in
Windows 8, but the fullscreen Start menu is still there in Windows
10, ready to block out all your work at a single press of the
Windows key! But, if you liked it, go to Settings > Personalisation >
Start and tick the box marked ‘Use full-screen Start when in the
desktop’. Note that wording: it now won’t actually cover up your
apps like it did in Windows 8.
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Get to know Cortana

Meet the digital assistant that’s here to help you
– she can even recognise the sound of your voice

icrosoft’s virtual personal assistant
takes its name from a character in the
Halo series of videogames. That
incarnation of Cortana – an AI who is
outwardly female (having been created from the
brain patterns of a female scientist) and never
seems to have been provided with quite enough
clothes – can hack alien computer encryption
and ﬂy captured spaceships.

M

The Windows 10 version is perhaps a little less
powerful, but comes in useful all the same. She
can search using natural language terms, and by
using voice activation just like Siri does on your
iPhone. And if the idea of voice controlling your
PC alarms you, or perhaps your computer isn’t
equipped with a mic, then you can still interact
with Cortana through the keyboard, typing your
queries for Cortana to answer.

up
1 Set
Depending on how your PC has been configured, you may
need to switch Cortana on in order to work with her. The first time
you try to search your PC, she’ll ask if you want to use her. Say no,
and the search box remains functional, but without the extra
features that Cortana brings. You’ll need to be connected to the
internet to use Cortana of course, because that’s how results are
queried and returned to you, just like Apple’s Siri.

down your search
3 Narrow
To stop Cortana searching things she doesn’t need to, and
speed up the return of those internet results, you can tell her
exactly what you’re looking for, which is great when it comes to
finding apps and files in particular. So if it’s definitely an app you
need, rather than a picture or video, start your search query with
‘app:’. If it’s a setting, type ‘setting:’. For a document... you get the
idea. You can force a web search with ‘web:’ too.
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Cortana
2 Personalise
To make Cortana as useful as possible she needs to address
you personally. Tell Cortana your name and where you live and
she can adapt herself to you. If you’ve opted for her to speak
results back to you, she’ll call you by name and allow you to
correct her pronunciation if she gets it wrong. Tell her your
interests, and appropriate news snippets will appear when you
open Cortana’s panel. You can do all this from the settings.

Cortana for tech support
4 Use
If there’s something you want to know how to do in
Windows 10, a publication like this one can help of course. If you
need to know really quickly, try asking Cortana instead. Type your
query in, and it will appear in the list of results under ‘Can I help?’.
Clicking this gets you the Microsoft help files, and in the case of
many common tasks a walkthrough will show you how it’s done.
Don’t forget the tips on these pages though!

Cortana in Edge
5 Use
Cortana can also help you as you browse the internet. To
enable it in Microsoft Edge, go to Settings > Advanced Settings >
View Advanced Settings and under ‘Privacy and Services’ enable
‘Have Cortana Assist Me in Microsoft Edge’. Now, as you explore
the web, you’ll get helpful additions such as song lyrics if you’re
listening to music, or links to apps if the site you’re using has one.

Cortana to only reply to you
7 Train
It’s hilarious to shout ‘Xbox off!’ at someone else’s Xbox with
Kinect voice control switched on, shutting the box down in the
middle of what its poor user was doing, so train Cortana to
respond only to your voice by selecting the ‘Learn my voice’
option in Settings and speak the test phrases. You’ll find that
Cortana keeps learning anyway, so over time the more you use
Cortana the better she will be at just about any task!

voice commands
6 Use
Click the microphone icon next to the search box, and you
can speak your questions and instructions to Cortana. You must
have ‘Search online’ enabled in Cortana settings to use voice
search, otherwise the mic icon disappears. If you select the
option, she will respond to a cheery ‘Hey Cortana’ – but this will
increase battery usage on portable devices, so is only worth
turning on if you’re sure you’ll use it.

natural language to search
8 Use
If you want to set yourself a reminder, you don’t need to find
a calendar app and input what you want to do, and when, just
type or speak it into Cortana as you would when talking to
someone. Saying ‘Remind me to take a screen break in an hour’ or
‘Remind me to buy flowers on the way home’, for example, will
trigger a notification at the appropriate time. Now there’s no
excuse to forget that meeting or important date again!
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Pop-ups pop up
everywhere on
the internet these
days – and they
can really ruin
your enjoyment of your
favourite websites.
Some web browsers do
include pop-up blocking
options, but these don’t
always work that well. So
this month, we’re looking at
four brilliant tools that will
do the job better and for
free. You can find out more
on page 95. We also take a
look at Lenovo’s Surface
Pro alternative, the Miix 510
(page 84); the brilliantly
affordable Chuwi LapBook
(page 86) and cast our eyes
over AOC’s lovely Porsche
Design display (page 88).

84 Lenovo Miix 510

86 Chuwi LapBook 12.3

88 AOC PDS241 Porsche Design

95 Best free pop-up blockers

Looking for an alternative to the Surface
Pro? Then try this 2-in-1 tablet hybrid…

Nick Odantzis Deputy Editor
windowsmagazine@futurenet.com
w

Our pr

Smart design and low pricing make this
Chinese laptop one of the best we’ve seen

This 23.8-inch monitor looks great on any
desk, but is there more to it than that?

Banish adverts and other annoyances
with our pick of the four best apps

…

The Upgrade sectttion is your key to finding out about the latest
T
products, all desig
p
gned
to help you
g
y get
g more ffrom yyour PC

You can trust our reviews

Our reviewers are 100 per cent
independent, with years of
experience in the world of computing.
Our rigorous testing procedures mean
that only genuine, high-quality
products are awarded high star ratings.
If you see an item of hardware bearing
a high score, you can be conÀdent that
it is an excellent product.

RATING EXPLAINED

Superb

We choose the best products

Thousands of new PC products
are released every year and
choosing between them can be an
impossible task. Our experts select only
the best hardware and software to
feature in this magazine. Even better,
our star rating system makes it simple
to Ànd the best products, giving you
a fast, trustworthy guide.
Very good

Good

How we review

Our expert reviewers guarantee
to test every piece of hardware
rigorously and thoroughly, using
only acknowledged experts to
establish the worth of a product.
We always review from the viewpoint
of our readers; the day-to-day
practicality and quality of a product
is paramount.
Disappointing
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Lenovo Miix 510

£849 | $669 www3.lenovo.com
Can Lenovo’s latest take the ﬁght to Microsoft’s Surface Pro 4?

T

he 2-in-1 tablet hybrid is no
longer a novelty. The market
is ﬂooded with devices with
detachable keyboards that oﬀer up
Windows 10’s capabilities as a
tablet and desktop OS, including
Microsoft’s own Surface range.
While the new Surface Pro is
Microsoft’s latest, the Miix 510 is
more akin to the Surface Pro 4 or
Acer’s Switch Alpha 12.
The Miix 510 is equipped with a
latest-gen Kaby Lake version of the
Intel Core i5 and a strong central
pairing of 8GB of RAM and a 256GB
SSD. There are cheaper variants, but
this is the one to go for in our book.
The Miix design language centres
around two watchband-style
hinges that give you more control
and ﬂexibility than the Microsoft
Surface when it comes to the angle
of the kickstand and therefore the
screen. Another plus is that the
keyboard cover is included with the
device – unless you nab a deal you
don’t get that with the Surface Pro.
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Like previous models, the Miix
510 comes with an active pen. Pens
have more functionality these days
thanks to the new Windows Ink
feature in Windows 10, and they’re
an essential add-on for any tablet
that takes itself seriously. Lenovo’s
stylus doesn’t attach to the device
via a magnet, although there is a
pen loop on the included slipcase.

Price and availability
There’s an Intel Core i3 variant of
the Miix 510 for £750 ($599), which
has half the amount of memory
and storage as well. The Core i3
version will be ﬁne for most basic
tasks, but if you’re looking at any
kind of photo or video editing we’d
recommend the Core i5. At the time
of writing, you’re looking at £849
($669) for this device.
The Surface Pro 4 has come
down in price, but for a model with
similar spec to the Miix 510 you can
expect to pay around £899 ($729), a
signiﬁcant premium, especially

when you factor in the cost of the
Type Cover keyboard as well.
Depending on where you look,
the Acer Switch Alpha 12 is around
the same price, with Acer recently
announcing a new version.

Design
The Miix 510 is a well-designed
tablet hybrid. That’s not to say it’s a
stunner, but it does look distinctive
and those watchband-style hinges
give it a certain something. The
detachable keyboard with optional
backlight also doubles up as a
protective faux leather folio case,
which works well and is good to
grip hold of. It’s a more premiumfeeling aﬀair than Microsoft’s
Surface Pro 4 Type Cover – and you
get Lenovo’s version for free.
The side controls – especially the
power button – are a little plasticky,
but it’s a minor complaint.
Without the keyboard cover, the
Miix 510 weighs just shy of 900g.
That’s OK to hold in one hand,

Upgrade
Lenovo Miix 510
KEY FEATURES
Lenovo Miix 510
Supplier www3.lenovo.com/
Processor 2.7GHz Intel Core i5-7200U
Graphics Intel HD 620
Memory 8GB
Storage 256GB PCIe SSD
Display 12.2-inch IPS, 1,920x1,080 pixels
Connectivity 802.11ac Wi-Fi; Bluetooth
4.0; 1x USB 3.0 Type-C; 1x USB 3.0; 1x
audio combo jack
Weight 1.25 kg
Dimensions: 300x99x205mm

leaving the other free to draw or
write on the display. However, this
means you’re going to want to
brace it against something or put it
on a ﬂat surface before too long.
The keyboard cover sports
Lenovo’s AccuType-style keys,
which are slightly curved along the
bottom edge. They’re suﬃcient in
size but don’t possess as much
travel as the Surface Pro 4 cover,
and this doesn’t make for a great
experience when you have a lot of
words to type. The biggest
problem is that the keyboard ﬂexes

use, it’s not a problem using Full HD
on the Miix 510. It depends on how
determined you are to have
best-in-class specs.

Performance
Because we’re looking at the Intel
Core i5 variant of the Miix 510 here,
performance isn’t an issue. There’s
plenty of ‘everyday’ power on oﬀer.
Naturally, you’re not talking
about gaming performance, but
between the fast PCIe SSD and the
processor, there was no issue with
any kind of everyday tasks we tried.

“Because we’re looking at the Intel Core i5 variant
of the Miix 500 here, performance isn’t an issue”
a bit. And if you’re a hard typist in
any way, the keyboard bounces
rather angrily.
Elsewhere, the bezels around the
display seem wide, but they’re not
too much and they don’t make the
device look chunky in any way.
Quite the opposite, the tablet looks
sleek and professional. Naturally,
you’d expect this for a device with a
price in this ballpark.

Display
There’s a lot to like about the
display here – blacks are black and
colours are vibrant. Viewing angles
are excellent. What is a bit more of
a problem is the resolution, which
sticks with Full HD, whereas the
Surface Pro 4 and Acer Switch 12
feature 2,160 x 1,440 resolutions. In

Plus there’s plenty to like in terms
of entertainment performance and
the Miix 510 is great for watching
movies on with the kickstand.
Talking of the kickstand, it’s an
eﬀective bit of industrial design
from Lenovo. The ability to poise
the device at almost any angle is a
boon. Elsewhere, the edges of the
device are covered by the usual fan
and speaker grilles plus ports, but
everything is integrated nicely, with
power, USB-C and USB 3.0 on one
side and power, volume and a
headphone jack on the other.
Writing detection is responsive
enough to jot down notes swiftly,
and the pen is slim enough to use
for long periods.
In our benchmark tests, the Miix
510 was, well mixed. It scored a

credible 6570 in our GeekBench
multi-core test, but battery life was
sub-standard compared to rivals,
lasting four hours and 40 minutes
during our looped video test, 35
minutes shorter than the Surface
Pro 4. The Miix 510 lasted two hours
57 minutes on the harsh PCMark 8
battery test. The Surface Pro 4
managed 18 minutes more.
It’s great to see USB-C included,
but we’d have preferred a USB-C
charger rather than the roundended charger we get here. Since
Microsoft is still ignoring USB-C,
this is a deﬁnite plus for the Miix
over the Surface.
Lenovo hasn’t included a
microSD port, which is surprising
but not a deal-breaker. As you’d
expect, you get a 2MP front camera
for video calling, as well as a 5MP
unit on the back.
Dual-microphones cancel out
background noise and we had no
problem being understood on calls.
In terms of audio playback, it’s
ﬁne for everyday viewing, but you’ll
want to hook it up to a Bluetooth
audio system (there is a headphone
jack, too) for movies or music.

Summary
So despite a compelling spec sheet
and generally likeable appearance,
the Miix 510 remains hard to
unequivocally recommend.
That’s because of the rivals that
loom above and beside it, not least
the Surface Pro 4. It’s the battery
life that really lets it down.
But if it’s price that’s your main
motivator, you’ll ﬁnd the Miix 510 a
fantastic alternative choice.Q
A great-value tablet, as long as
you don’t mind its Full HD screen
and rather limited battery life.
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Chuwi LapBook 12.3
£239 | $312 http://en.chuwi.com

Here’s a Chinese brand that’s not struggling to innovate

C

huwi is one Chinese PC
manufacturer that hasn’t
been short on product
releases over the past 12 months
despite being a relative newcomer
outside of mainland China.
Available online from GearBest
(www.gearbest.com), the LapBook
12.3 is the latest addition to this
range and positions itself as a
‘souped-down’ laptop equivalent of
the Microsoft Surface Pro 4. In other
words, if the Surface Pro 4 had a
laptop equivalent, the LapBook
12.3 would have been its direct
competitor – and no, we’re not
counting the Surface Laptop as
such a device.

Design
In many respects, comparing the
LapBook 12.3 with the Surface Pro
4 is a distraction. A better way to
think of this device is: if the iPad Pro
and MacBook Air had a lovechild,
it’s likely that it would look like the
LapBook 12.3. There are very clear
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design cues that point to some
serious aesthetic inspiration from
Apple’s range of products – but
then Apple’s legendary CEO, Steve
Jobs, once said that the company
had “always been shameless about
stealing great ideas.”
Given the black rim surrounding
the screen and the thick bezel, the
wedge proﬁle, all-metal chassis and
the ‘mono-hinge’ along with a
brushed aluminium ﬁnish, it’s not
surprising that many people’s initial
thought will be that it’s an ‘Apple’
when glancing at this notebook for
the ﬁrst time.
Like the iPad Pro and the Surface
Pro 4, the LapBook 12.3 has a
display with a 3:2 aspect ratio and
like the latter, it is a 12.3-inch model
with a 2,736 x 1,824 resolution.
That’s almost ﬁve million pixels,
more than twice what you’d expect
from a pair of Full HD monitors.
That’s also a higher pixel density
than either the iPad Pro or Apple
MacBook Pro Retina Display have.

This is a rather large laptop at
293x200x15mm with a weight of
just under 1.4kg. A major element
that contributes to the big footprint
of the LapBook 12.3 is the wide
bezel around the display – tablet
and laptop vendors use these
because they come in handy for
holding your device in touch mode.
But this laptop isn’t touchcapable and the matte ﬁnish only
serves to underline this point, so all
in all, this is a rather confusing
move by Chuwi here.
Elsewhere, the notebook packs
one USB 3.0 and one USB 2.0 port,
an HDMI connector (that can
support 4K at 60Hz), a TF Card (aka
microSD) slot, a 3.5mm headphone
socket and a proprietary power
port which connects to a 24W (12V,
2A) brick-style power supply unit.
Flip the machine over and you
will discover a ﬂap that hides an
empty slot where you can plug in
an M.2-sized SSD (not included in
the price), plus there are two

Upgrade
Chuwi LapBook 12.3
KEY FEATURES
Chuwi LapBook 12.3
Supplier www.gearbest.com
Operating system Windows 10
Processor 1.1GHz quad-core Intel
Celeron N3450 (Apollo Lake)
Graphics Intel Graphics HD 500
Memory 6GB
Storage 64GB eMMC flash
Display 12.3-inch IPS, 2,736x1,824 pixels
Connectivity 802.11ac Wi-Fi; Bluetooth
4.0; TF Card Slot (aka microSD); M.2 SSD
expansion slot; 1x Micro HDMI; 1x USB
3.0; 1x USB 2.0; 1x 3.5mm headphone jack
Battery Up six hours between recharges
Dimensions 293x200x15mm

under three hours 30 minutes, due
partly to a low-capacity battery
(36.33Whr). Our test involves
playing a YouTube video of a
count-up timer with brightness set
to 100% and all other settings left
untouched except for power saving
(we selected ‘never shut down’,
‘screen never go dark’). As ever,
your mileage may vary when it
comes to battery longevity.

Summary
speaker grilles and four rubber feet
on the underside.

Speciﬁcations
Inside the LapBook 12.3 is the
increasingly popular Intel Celeron
N3450, a 14nm member of the
Apollo Lake family, which is a
quad-core (four-thread) processor
with a 1.1GHz base frequency
bursting to 2.2GHz. It has a Thermal
Design Power (TDP) of 6W and a
2MB cache, along with integrated
Intel HD Graphics 500 clocked at
200MHz, bursting to 700MHz.

this laptop and yes, it does feel like
a MacBook; at least to the touch.
The display is gorgeous, and it’s
probably one of the best we’ve ever
seen on an entry-level laptop.
There’s hardly any ﬂex on the
keyboard and touch typing is an
enjoyable experience with great
feedback and 1.5mm of key travel.
Ditto for the touchpad; it’s more
than decent in terms of size,
sensitivity and precision.
Opting for a 3:2 aspect ratio for
the display ensures that the palm
rests are bigger than average,

“This laptop is a bargain, especially with its
storming 2,736 x 1,824 resolution display”
Backing that up is 6GB of system
RAM, probably in a 4GB plus 2GB
setup, designed to make the most
of the dual-channel memory
support of the Celeron N3450. Note
that the CPU supports up to 8GB of
RAM so in theory, assuming that
none of the memory modules are
soldered in and the memory slots
are accessible, you should be able
to swap them if you wish.
As expected, the storage
subsystem consists of 64GB of
eMMC memory – Toshiba 064G93,
a popular model among Chinese
brands – which is one way that
vendors cut down on costs.

Performance
The magnesium aluminium alloy of
the chassis gives a premium air to

which is great news for those who
spend hours typing on a laptop.
Don’t expect miracles when it
comes to performance though.
Most of the LapBook’s benchmark
numbers are noticeably lower than
the competition – the Teclast X3
Plus, Chuwi Hi13 or the Onda
Xiaoma 31 – despite using the same
Intel Celeron processor and an
equal amount of memory.
Two potential explanations for
this are that the much higher
screen resolution is taxing the
on-board GPU far more, and that
the processor is being throttled
during the benchmarks as it’s
overheating. The LapBook 12.3 did
feel quite warm during our tests.
Another disappointment is the
battery life, which stands at just

We’ve ended on talking about the
downsides of the Chuwi LapBook
12.3 here, but let’s be clear – the
battery life and the performance
are two sore points in an otherwise
near-perfect picture. If you can live
with these then this notebook is a
bargain, especially with its storming
2,736 x 1,824 resolution display.
Its ﬁnish comes close to far more
expensive top-end laptops and its
component list – although not
perfect – exceeds what you would
get from a similarly priced device in
the UK. But clearly, the LapBook’s
12.3 screen is the showstopper and
the main reason why you’d want to
buy this machine.
The Chuwi LapBook 12.3 is a
deﬁnite upgrade from the LapBook
14.1, and should Chuwi solve the
two outstanding problems we’ve
highlighted, it will have a sure-ﬁre
winner on its hands. The Jumper
EZBook 3 Pro or the Yepo N737A,
both of which we’ve yet to review,
are the closest rivals in terms of
speciﬁcations, but still can’t oﬀer
the same 5-megapixel display. Q
Chuwi’s LapBook 12.3 is a hell of a
lot of laptop for your money, with
a showstopper of a display.
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AOC PDS241 Porsche Design
£189 | $240 www.aoc.com/

Is this 23.8-inch monitor all style and no substance?

T

he AOC PDS241 Porsche
Design aims to challenge the
notion that monitors need to
be simple and boring-looking
rectangles, and persuade us that
they can in fact be beautiful
accompaniments to our PCs that
anyone would be happy to have
displayed on their desk.
As the name suggests, AOC has
teamed up with famous design
house Studio F. A. Porsche, best
known for bringing contemporary
and stylish designs to watches –
and, of course, cars.
However, while the design is
certainly exciting, on paper the
speciﬁcations of the AOC PDS241
Porsche Design are rather less so,
with a standard 1080p Full HD IPS
screen with 60Hz refresh rate and a
rather conservative screen size of
23.8 inches (there’s also a 27-inch
version – the AOC PDS271).
This isn’t a monitor designed to
dominate the desk then, nor will it
really appeal to gamers who
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demand high refresh rates and
even higher resolutions.
So, a non-ﬂashy monitor that’s
designed by one of the world’s
most respected design houses? It
sounds like the AOC PDS241
Porsche Design could be suﬀering
from a bit of an identity crisis.
However, while the design is
certainly premium the price is far
from it, at a very reasonable £189
(around $240). And that tempting
price goes some way towards
making up for a lack of features.

Design
One area in which the AOC PDS241
Porsche Design has almost no
peers is its design – this is a
seriously attractive bit of kit that
will improve the aesthetics of
pretty much any desk you put it on.
The incredibly thin bezels (AOC
describes it as a ‘frameless’ design,
and while it’s not quite there, it’s
close), and slim 5.2mm depth gives
the AOC PDS241 a minimalist look.

The bottom bezel is thicker, with
a silver design, and hosts the AOC
logo (also printed on the back).
Nowhere on the body will you ﬁnd
the name of Studio F. A. Porsche,
but it does appear when you turn
on the monitor.
The AOC PDS241 Porsche Design
isn’t uniformly thin, as the lower
third of the body becomes slightly
thicker to accommodate the
electronics. However, overall this is
an impressively thin monitor –
which also makes it light. While you
probably won’t be carrying it
around much, this lightness is
appreciated when you ﬁrst set up
the AOC PDS241 on your desk.
To make the body of the monitor
as thin as possible, the AOC PDS241
Porsche Design has a bulky
breakout box that includes the
both the power port and a full size
HDMI port. This box connects to
the monitor via a micro HDMI cable
which provides both power and
video signal.

Upgrade
AOC PDS241 Porsche Design
KEY FEATURES
AOC PDS241
Supplier www.aoc.com/
Screen size 23.8”
Aspect ratio 16:9
Brightness 250 nits cd/m2
Contrast Ratio 1000:1
Viewing Angle 178-degrees
Response time 4ms
Display resolution 1,920x1,080 (Full HD)
Connectivity 1x HDMI
Weight 3.15kg
Dimensions 541.1x416x178.5mm

While the box is quite large, it has
the same silver design as the rest of
the monitor, so it doesn’t look too
bad – plus it’s pretty easy to hide
out of sight, which is presumably a
feature of the design.
While the emphasis on design
had produced a lovely-looking
monitor, it comes at the cost of
features, with the AOC PDS241 only
including a single HDMI port. There
are also no built-in speakers;
instead there’s a headphone jack
you can plug external speakers (or,
of course, headphones) into.

controlled by a single button. You
press this once to bring up the
menu, then press it repeatedly to
navigate through the options. To
select an option, you stop pushing
the button for a few seconds.
This isn’t ideal; we appreciate that
AOC wants to keep buttons to a
minimum, but using the menu
quickly becomes a chore when you
need to tweak the settings.
For example, if you want to
increase the brightness you press
the button a number of times to
select the option for adjusting the

“The image quality is superb, with colours looking
vibrant in our tests. Contrast is also very good”
A single button located on the
underside of the monitor’s body is
used to bring up and navigate the
on-screen display menu. However,
this simplicity makes navigating the
OSD menu rather clumsy at times.
The stand continues the brushed
metal theme of the monitor, with a
simple yet elegant curved design.
The micro HDMI port connects to
the monitor at the tip of the stand.
So, if you’re happy with just a
single HDMI port, and value
aesthetics over all else, then you’ll
be very happy with the AOC
PDS241 Porsche Design.

Performance
As we’ve mentioned, the OSD
menu for tweaking the settings of
the AOC PDS241 Porsche Design is

brightness, then you need to
continue to press the button to
increase the brightness.
The issue here is the adjustment
only goes one way. The brightness
is set to 50 by default, so if you
want to set it below that you have
to keep pressing the button to go
past 100, then start from 0 and
keep pressing until you reach 50.
Not ideal. The good news is that
out of the box the AOC PDS241
Porsche Design’s image quality is
very good, so hopefully tweaking
can be kept to a minimum.
Without adjusting the settings of
the AOC PDS241 the image quality
is superb, with colours looking
vibrant in our tests. Contrast is also
very good, with deep blacks in dark
scenes, and the anti-glare coating

of the screen ensures images look
great even in bright environments,
and from various viewing angles.
1080p Full HD videos look very
good; however the results aren’t
impressive when playing games.
With its 60Hz refresh rate and 4ms
response time, this is clearly not a
monitor designed for gaming – and
that shows, with blurred visuals
during fast-paced scenes.
If you’re using this monitor for
general work, and occasionally
watching movies, then the image
quality will be perfectly acceptable.
If you require complete colour
accuracy – if you’re editing video or
photos, for example – then you’ll
need to splash out on a more
expensive monitor, since the AOC
PDS241 doesn’t reproduce colours
to a professional standard.

Summary
The AOC PDS241 Porsche Design is
a gorgeously-designed monitor
that would brighten up any desk.
Thankfully, the monitor continues
to impress after you’ve turned it on,
with very good image quality.
However, the AOC PDS241 isn’t as
conﬁgurable as other monitors,
which means that if you rely on
colour accuracy and image quality
for creative work, this isn’t the
monitor for you.
The design also means ports are
limited to just one HDMI and a
headphone jack – and gamers in
particular should steer clear.
But if you want a simple,
eﬀective, and nicely-designed
monitor that’s also aﬀordable,
you’ve come to the right place. Q
If you’re looking for a stunninglydesigned monitor at a fantastic
price you can’t go wrong with this.
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JBL Playlist

£149.99 | $149.95 www.jbl.com
The budget Bluetooth behemoth enters the multi-room space

J

BL is a company that has an
exhausting number of
Bluetooth speakers on the
market, and these bright and
colorful rugged speakers have
become outdoor music staples.
But the JBL Playlist is something
a little diﬀerent. Instead of being a
portable battery-powered speaker,
this is one meant for the home that
you’re going to need to keep
plugged in at all times.
The reason for this change is that
this isn’t a Bluetooth-only speaker.
Instead the JBL Playlist is equipped
with a couple of diﬀerent Wi-Fi
streaming technologies – namely,
Google Cast and Spotify Connect
– that make it more similar to a
Sonos-style multi-room setup.
For the most part this
functionality is well implemented,
resulting in a speaker that’s hugely
versatile. By integrating into these
well-established ecosystems, JBL
has ensured that you get all the
functionality you’d expect from a
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multi-room system without the
company having to build its own
dedicated app and services.
The only potential downside is
that the Playlist still absolutely has
JBL’s signature sound which, while
at home in a rugged, outdoor
Bluetooth speaker, might feel out of
place in a domestic situation.

Design and features
Available in black or white, the JBL
Playlist is a fun-looking speaker
that’s all bold curves and mesh.
Aside from a small JBL logo and
Wi-Fi connectivity light, the front of
the speaker is otherwise one large
speaker grille. Along the top there
are a couple of control buttons.
From left to right there’s an on/oﬀ
button, volume down, play/pause,
volume up, and a button to put the
speaker into Bluetooth mode.
Yes, in addition to supporting
streaming over your home internet
connection, the JBL Playlist can also
be streamed to via Bluetooth,

which is helpful if your home
network is being slow or unreliable.
Direct controls on the speaker
are also helpful. Depending on the
speed of your home network there
can sometimes be a delay when
you want to turn the speaker’s
volume up or down – directly
controlling the speaker removes
this problem.
Around the back of the speaker
you also have a 3.5mm input (just
in case you want to opt for a wired
connection for any reason) and a
two-pin power connector that
accepts the speaker’s annoyingly
short power cable.
If you have ever set up a Google
Chromecast before then the setup
process for the JBL Playlist
shouldn’t be too unfamiliar. Simply
download the Google companion
app, Google Home, and it will guide
you through the steps needed to
connect to the speaker and
subsequently get it connected to
your home’s Wi-Fi.

Upgrade
JBL Playlist
KEY FEATURES
JBL Playlist
Supplier www.jbl.com
Drive units 2x 57mm woofers
Power (RMS) 2x 15W
Frequency response 60Hz-20kHz (-6dB)
Signal to noise ratio >80dB
Connectivity 802.11ac Wi-Fi; Bluetooth
4.2; 3.5mm analogue audio input
Power consumption (sleep mode) <2W
Weight 1120g
Dimensions 316x147x131mm

If you want to sync up the
speaker with other Google
Cast-equipped speakers then the
setup is a little more involved, but
it’s still handled by the same app.
We got the JBL Playlist paired
with a Chromecast Audio to allow
the same music to be played across
two diﬀerent rooms, and the two
streams synced perfectly.
It might seem strange to include
support for both Google Cast and
Spotify Connect. After all, both are
accessed in the same way in the
Spotify app where you select the

worse – it shares the same DNA
that’s made the company’s
Bluetooth speakers so popular.
In short, that means a bass
response that’s thick and chunky,
with mids and trebles taking a
backseat to a certain extent.
It seems only ﬁtting to start oﬀ
our listening session with some
energetic pop punk from The
Oﬀspring. The driving oﬀbeat
drumbeat in You’re Gunna Go Far,
Kid has power aplenty, with the
Playlist providing a really energetic
listening experience.

“It’s simply much easier to control Spotify with a
keyboard and mouse rather than using a phone”
JBL Playlist from the bottom of the
Now Playing screen. Plus, Google
Cast does more or less everything
Spotify Connect does, but with
support for many more apps
including Tidal and Deezer.
However, Spotify Connect also
has its own functionality whereby
you can use Spotify players on a
desktop or laptop to control the
speaker – something which isn’t
available using Google Cast. We
found this especially useful when
listening to music while working;
it’s simply much easier to control
Spotify with a keyboard and mouse
rather than using a phone.

Performance
This is a JBL speaker through and
through, and so – for better or for

It’s a similar story if you switch to
From Her Lips to God’s Ears (The
Energiser) by Against Me! where the
song’s frantic pacing is delivered in
spades by the speaker.
When a JBL representative
described this as a speaker that’s
meant for parties, we can see
exactly where they’re coming from.
But the JBL Playlist is a lot less
sure of itself when it comes to more
laidback tracks like I Fall In Love Too
Easily by Chet Baker or It Was A Very
Good Year by Frank Sinatra, where
you’ll ﬁnd the mids and trebles
getting lost in the mix a little, not to
mention not having quite the same
level of detail.
This isn’t a speaker that responds
well to being put in a corner and
used for background music. It

wants to be front and centre in a
party environment.
If you’re looking for a more
laidback listen, then the slightly
more expensive Sonos Play:1 might
be more up your alley.
Our only other issue with the
speaker is that the stability of the
audio playback varies depending
on the quality of your home’s Wi-Fi
signal. On a couple of occasions
during out test, the speaker got
kicked oﬀ our network, forcing us
to restart it to resume playback.
This might not be a problem if
you have a more robust network,
and it’s also worth noting that
switching to a Bluetooth
connection will remove your home
network from the equation.
Nevertheless, it’s a problem that
rarely aﬀects a Chromecast Audio
that we have connected to the
same wireless network.

Summary
If you like the punchy and energetic
sound signature of JBL’s existing
Bluetooth speakers, then the
Playlist oﬀers exactly that in a
home-listening form factor.
The connectivity options are
what you need in this setting, and
make it easy for everyone in your
home to get their music playing no
matter which streaming service or
device they use.
But if you’re looking for a speaker
to sit discreetly in a corner and play
ambient music then you might ﬁnd
the JBL Playlist a little too punchy
for this purpose.
As a party speaker, though, it
does its job with gusto. Q
You can connect everything you
need to this speaker, which has a
real punch to its sound.
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BLUETOOTH HEADPHONES
Don’t let cables come between you and your favourite music.
Liberate yourself with these Bluetooth wireless headphones
and their sound-boosting aptX tech

2

1

3

1 Sony MDR-1000X
£360 sony.co.uk

Sony’s top-end wireless cans are the
most expensive on test, but they’re also
the smartest. They customise noisecancelling to suit your wearing habits,
while two Ambient Sound settings let in
voices or background noise. It all works
brilliantly. The synthetic leather styling is
dull, but they’re super comfy and easy to
use thanks to the slick gesture control
pad. Sony’s high-res 40mm drivers
deliver wonderfully rich and refined
sound with no bright edges, picking out
rarely noticed nuances and supplying
deep, tightly controlled bass. The
20-hour battery life of these headphones
is also impressive.
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3 Marshall Monitor

2 AKG N60NC
Wireless

Bluetooth

Lighter and more compact than most
noise-cancelling rivals, the N60s are
perfect for travelling. They fold flat into a
pocket-friendly size and offer 15 hours of
Bluetooth aptX playback, or 30 hours
with Active Noise Cancelling only. The
metal housings and matt black finish are
stylish, topped off by comfortable
memory foam ear pads and intuitive
controls. Superb noise-cancelling paves
the way for some fabulous sound quality,
which is powerful, well-balanced and
detailed. Full-bodied mid-range and
beefy bass result in a satisfying sound.

These Bluetooth aptX headphones
mimic the look of Marshall’s iconic guitar
amps with a faux-leather finish, brass
accents and curly wires. Build quality is
excellent, and the compact over-ear
pads offer decent isolation, but they
squeeze the head too tightly for comfort.
The 30-hour playback time beats pricier
rivals, although there’s no powerdraining noise cancellation. In action, the
Monitors fall short of audiophile status
but deliver a well-balanced sound, with
incisive treble and deep bass that never
overpowers other sonic elements.

£250 uk.akg.com

£219 marshallheadphones.com

Upgrade
Bluetooth headphones
ur good mate Pinocchio
didn’t like being tethered
by wires and neither do we,
particularly when listening
to music while out and about.
Thankfully there’s a wide range of
wireless headphones to choose from,

O

which use Bluetooth technology to
receive music from your mobile device
or PC. With new smartphones such as
the iPhone 7 dropping physical
headphone outputs altogether,
wireless cans like these are becoming
more important than ever.

And if you’re worried about
sacrificing sound quality for the
convenience of Bluetooth, don’t be –
all of the headphones on test support
aptX, the audio codec that allows CD
quality sound to be transmitted via
Bluetooth. Let streaming commence…

6

4

Winner!

5

4 Audio-Technica
ATH-DSR7BT

5 Bang & Olufsen
Play H7

6 Bowers & Wilkins
P7 Wireless

Audio-Technica aims to redefine wireless
headphones with Pure Digital Drive,
which keeps the signal in the digital
domain from source to driver. The lack of
a DAC means there’s no 3.5mm jack;
instead you get a USB port for high-res
playback from a laptop, alongside
Bluetooth 4.2 with aptX HD and 15 hours
of playback. Build quality lives up to the
price tag, with robust construction and
head-caressing memory foam earpads.
The sound is insightful and precise but a
tad clinical – more punch and warmth in
the bass department wouldn’t go amiss.

Chic and beautifully built, the H7s are a
classic product from B&O. The soft
lambskin over-ear cushions are secure
yet easy to wear for long periods, while
the inclusion of an aluminium touchsensitive control panel makes operation
easy on the go. The replaceable battery
offers a respectable 20 hours of
playback, but the lack of noise-cancelling
is a pity at this price. Without it, the H7s
muster a clear, detailed sound with
sparkling treble and solid bass, but they
could do with a bit more muscle to really
make the music you play sing.

Unearth the P7 Wireless headphones from
the box and it’s love at first sight thanks to
their gorgeous design and premium
construction. The stitched leather
headband and durable metal hinges exude
quality, while silky-soft memory foam
earpads facilitate hours of comfortable
listening. Good job too, as you’ll get a
decent 17 hours of Bluetooth aptX
playback. Play some tunes and the
performance is easily the best in test. Their
refined, full-bodied, tight and powerful
bass will reignite your passion for songs
you’ve heard a thousand times.

£299, eu.audio-technica.com

£329, beoplay.com

£319, bowers-wilkins.co.uk
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ON SALE NOW!
Available at WHSMITH, MYFAVOURITEMAGAZINES.CO.UK
or simply search for Mobile Choice in your device’s app store

Software Test
Free pop-up blockers

THE BEST FREE

POP-UP BLOCKERS
Tell pop-ups to pop off

T

he phrase ‘pop-up’ is a
bit of an understated
term given the
manipulative form of
today’s invasive adverts.
Yes, they pop up. But they also
pop under, hide themselves
oﬀscreen until you least expect
them, leap up as new browser
tabs and, most gallingly, shout
annoying things at you until you
seek them out and shut them
down. Nobody wants to have to
deal with a pop-up.

Before we get into the best tools
to do away with them, please
note that most modern browsers
– including Microsoft Edge,
Google Chrome and Firefox –
come with built-in options for
disabling pop-up windows.
Here’s the thing, though:
whichever browser you use, you’ll
no doubt have noticed that its
default pop-up blocking skills
leave a lot to be desired. Time to
enlist the best third-party pop-up
blocker you can ﬁnd…
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1 Poper Blocker
https://poperblocker.com
Available as an extension for
Google Chrome, it was a head-tohead battle between this and
Popup Blocker Pro over which
would make it on to our list. The
slightly anonymous authorship
(and occasional suspicious

triggering of our anti-virus
software) of Popup Blocker Pro
saw Poper Blocker come out on
top, but it has a lot going for it
besides trustworthiness.
Designed speciﬁcally with the
web’s most pop-up ﬁlled sites in

Winner!

Poper Blocker does
a proper job of
blocking pop-ups.

mind – we’re sure you know the
sort of thing – Poper Blocker does
a great job at quashing the
majority of pop-ups, pop-unders,
unwanted new tabs, and even
those supremely-irritating site
overlay layers.
Poper Blocker is not, primarily,
an ad blocker; yes, it’s designed to
work harmoniously alongside
them if you so wish, but you can
equally run the extension alone to
support your favourite sites
without being hit by the most
egregious of online ads. With
active, personalised support from
its developer, Poper Blocker is only
getting better as time goes on.

RATING

2 AdwCleaner

www.malwarebytes.com/adwcleaner/
We recommended AdwCleaner a
couple of years ago, and we’re
maintaining our recommendation
here. Not necessarily because of
its capabilities at protecting your
browser – although it does a
brilliant job at squashing home
page hijacks and removing
toolbars – but because of its

standpoint; you never know what
data it’s collecting about you.
So, regularly ﬁre up AdwCleaner
– ﬁrstly, in its Scan mode, and then
in its Clean mode – to hunt
through your system for adware
and expunge everything from
fake Firefox proﬁles to full-blown
hidden advert factories.
AdwCleaner is now owned by
Malwarebytes, creators of our
favourite free anti-malware tool,
and that means one of two things:
either the program will inherit
technology from its new parent
and get better, or it’ll be folded
into Malwarebytes Anti-Malware
and disappear.

ability to clean up undesirable
software that you might not even
realise is there. If you’ve ever had a
mysterious pop-up outside of
your browser, or a cryptic (or
simply bothersome) system
message, there’s probably some
kind of malware present. That’s
not just bad from an irritation

Malware is a
common source of
pop-ups, so wipe
out infections with
AdwCleaner.
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RATING

Software Test
Free pop-up blockers

3 Noscript Security Suite
https://noscript.net

An extension made speciﬁcally for
Mozilla’s Firefox web browser (and
with functional equivalents such
as ScriptSafe available for Google
Chrome) Noscript Security Suite
isn’t what you’d traditionally think
of as a pop-up blocker – it doesn’t,
technically, block pop-ups at all.
What it does is oﬀer you ﬁne

websites blocked unless you
speciﬁcally whitelist those
locations, there’s no way that
anything malicious, let alone a
pop-up, could run without your
permission. This includes the likes
of cross-site scripting (XSS) attacks
and so-called ‘clickjacking’. Plus
Noscript Security Suite also helps
block advertising and malware
annoyances that use Flash and
other plugins.
Granted, you’ll have a bit of a
battle facing you until you have
whitelisted all of your favourite
websites, but once you have you’ll
quickly settle in to a world of
pop-up-free bliss.

control over the Javascript items
that are allowed to run in your
browser, meaning the sneaky
scripts, which manage to weasel
their way past Firefox’s built-in
pop-up blocker won’t get a
chance to run.
This is, naturally a boon to
internet safety – with scripts on all

Noscript stops
sneaky Javascript
operations that
produce pop-ups.

RATING

4 Goodblock

https://goodblock.gladly.io
We were consciously avoiding
covering direct ad blockers in this
list, but this one is a little bit
diﬀerent, so we’ll give it a pass.
Goodblock will, naturally, keep the
worst Chrome pop-ups at bay,

block advertisements on websites
unless you use its quick menu to
whitelist them, and helps stop you
being from tracked as you browse
around the web. It’ll also, er, show
you its own ads.

Goodblock: a
pop-up blocker
that helps raise
money for charity.

That practice is not as crosspurpose as it seems, because this
is an ad and pop-up blocker for
those with a conscience. Once a
day, Goodblock’s cute butterﬂy
mascot – the irrepressible ‘Tad’ –
will pop up in the corner of your
browser. Give him a click, watch
the curated ad that pops up in a
new window, and you’ll raise a
little money for Goodblock’s
charity partners, which include
Save The Children, Action Against
Hunger and Room to Read.
The ads are generally rather
good, too; we’re not going to say
you’ll want to click on them, but
you equally won’t regret it.

RATING
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